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1 System Description 

1.1 System Components 
 

The SETPOINT CMS System consists of these components: 

• VC-8000 Rack with eSAM, UMMCM and TMMCM Modules 

• SETPOINT Setup and Maintenance Software Applications 

• SETPOINT CMS Display Application 

• SETPOINT-PI Adapter Software 

• PI AF Server (2012 with SP2 or later) and PI AF SQL Database (SQL EXPRESS or higher) 

• PI AF Client (2012 with SP2 or later) 

• PI Server (2012 or later) 

• PI Process Book  (Optional) 

• PI Vision (Optional) 

Figure 1 shows the system components.  Computers may be combined as discussed in Section 2 
depending on the number of assets and dynamic points. 

 

 
Figure 1: System Components 
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1.1.1 VC-8000 

The VC-8000 is an API 670 machinery protection system that also incorporates high speed data 
acquisition for fast trending and collection of dynamic waveform data.  The VC-8000 was designed so 
that the high bandwidth condition monitoring data is separated from the critical protection data.  
Referring to Figure 2, note these design concepts: 

1. A separate alarm logic bus prevents condition monitoring data from affecting inter-module alarm 
voting. 

2. A separate condition monitoring network separates high bandwidth condition monitoring 
information from other protection system access data. 

3. A proprietary network separates the protection system processor from the display and condition 
monitoring system processor.  This protocol does not allow changes to critical machine protection 
parameters from the display or condition monitoring system. 

4. A separate Ethernet port connects the condition monitoring data server to the VC-8000 rack so 
that the high bandwidth condition monitoring data is separated from the critical protection data 
network. 

Alarm Logic Bus

UMMCM or TMMCM UMMCM or TMMCM

System Access Module 
Processor

UMMCM or TMMCM

Display and Condition 
Monitoring Data Module

System Access Module 
(SAM)

CMS (DAC) Ethernet Port

DCS  Port (Modbus)

Protection Network

Controller

PI Server
Proprietary 
Internal Protocol

Condition Monitoring Network

 
Figure 2: SETPOINT Separation of Protection and Management 
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1.1.2 OSIsoft PI System Components 

SETPOINT CMS is based on the OSIsoft PI System® platform.  Brüel & Kjær Vibro has developed 
methods with OSIsoft for storing waveform data into the PI Server database and for presenting 
standard machinery diagnostic plots for viewing and analyzing dynamic waveforms and transient 
data.  This section contains a brief overview of the OSIsoft PI System components.  For more detail, 
refer to the OSIsoft website (www.osisoft.com). 

PI Asset Framework™ Server 

PI Asset Framework™ (PI AF) lets you define a consistent representation of your assets and provide 
a structure for your information.  SETPOINT CMS uses PI AF Server to assign VC-8000 
measurement points to your plant processes and machine trains.  PI AF Server is included with PI 
Server 2012 and later and does not need to be purchased separately. 

PI Server 

PI Server is the real-time data collection, archiving and distribution engine that powers the PI System.  
Brüel & Kjær Vibro and OSIsoft have developed interfaces for storing dynamic waveforms and 
transient machine condition data on the PI Server along with the standard process data. 

PI ProcessBook™ 

PI ProcessBook is the graphical user display interface for the PI System.  ProcessBook is an optional 
component that is highly recommended for all users, allowing you to build machine train diagrams or 
process mimic diagrams.  You can launch the SETPOINT CMS Display Application directly from 
ProcessBook. 

PI Vision 

PI Vision is a web-client visualization tool for the PI System that provides secure access to PI System 
data.  PI Vision can provide similar displays as ProcessBook while also supporting mobile browsers 
and customized views for small screen devices. 

1.1.3 SETPOINT-PI Adapter 

The SETPOINT-PI Adapter is a software service that interfaces between the VC-8000 rack and the PI 
servers.  The computer running the SETPOINT-PI Adapter must also have the OSIsoft PI AF Client 
application installed. 

1.1.4 SETPOINT CMS Display Application 

The SETPOINT CMS Display Application is a display package that presents the machinery data 
stored in the PI System database in standard machinery diagnostic plots.  The computer running the 
SETPOINT CMS Display Application must also have the OSIsoft PI AF Client application installed. 

 

http://www.osisoft.com/


 

Page 12 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

1.1.5 Types of Data 

The SETPOINT Universal Monitoring Modules (UMM) collect and send several different types of data 
that are stored in the PI System database.  The software uses the various data types when creating 
the plot types as shown in Table 1. 

 

Table 1: Data Types 

Data Type Description Plot Using 

Static Processed and filtered values Trend, Shaft Centerline 

Vector Data Amplitude and Phase vector measurement at a 
specified multiple of running speed.  Requires a 
Phase Trigger assignment. 

Bode, Polar, Filtered Orbit and 
Timebase 

Synchronously 
Sampled Waveforms 

Data samples are collected in evenly spaced phase 
increments according to the current running speed.  
Requires a Phase Trigger assignment. 

Orbit, Timebase, Spectrum, 
Cascade, and Waterfall (in 
Orders) 

Asynchronously 
Sampled Waveforms 

Data samples are collected at a set sample rate. Asynchronous Spectrum, 
Cascade, and Waterfall, 
Asynchronous Timebase 

Speed Information on the relationship between the speed 
pulses and the synchronous waveform. 

Orbit, Timebase, Spectrum in 
Orders 

Status Alarm and OK status for each channel and 
measurement. Alarm List 

VC-8000 continuously sends static data at an 80 ms rate to the PI Server.  The PI System provides 
change detection that saves more samples while the machine conditions are changing rapidly and 
fewer samples when the machine is running at steady state.  This provides superior data versus a 
fixed pre-event buffer that may or may not have frozen data while the machine condition was 
changing. 
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1.2 Operation without Connection to a PI System 

Setpoint CMS also offers several options for collecting and viewing condition monitoring data when a 
network connection to a PI System is not available.  All vibration data is still available but these 
solutions lack the more advanced PI System features.  However, you can import data from Setpoint 
SD, XC, or HD into a PI System to provide a highly flexible combination of on-line, networked 
condition monitoring and off-line, remote data collection. 

These solutions are useful when: 

• Network connections are unavailable 

• The machines are located where installing and maintaining server computers is not practical. 

• Event data is sent to remote experts for analysis 

• Only Setpoint System data is required (no PI system data correlation is needed) 

Refer to the sections in this manual dedicated to each of these solutions for more information. 
Table 2:  Setpoint Offline Solutions 

Setpoint System Description 

SD SD card data storage.  The system stores condition monitoring data on an SD 
card installed in the SAM.  Remove the card and view the data with Setpoint 
CMS.  Setpoint SD is limited by the maximum SD card capacity of 32 GB. 

XC The adapter service stores condition monitoring data in a folder on a PC 
networked to the rack.  Setpoint XC can store larger amounts of data limited 
only by the available storage drive capacity. 

HD The SAM stores condition monitoring data on an internal solid state drive 
available in various sizes.  View the data using Setpoint CMS software 
networked to the rack. 

1.3 For more Information 

Download datasheets and other SETPOINT information at www.setpointvibration.com. 

• VC-8000 Operation and Maintenance Manual Document #S1079330 

• SETPOINT Reciprocating Machine Addendum Document #S1342998 

Get more information on the PI System at www.osisoft.com. 

• PI Server 2012 Configuring Security 

http://www.setpointvibration.com/
http://www.osisoft.com/
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2 Planning Your System 

There are several different implementations for the SETPOINT CMS system.  Each will be discussed 
in this section: 

• Implementing a small system (< 300 Points) 

• Implementing a large system (> 300 Points) 

• Time Synchronization 

• Protection from Network Failures 

You can implement your SETPOINT CMS System as part of an existing PI System or as a separate 
system. 

2.1 Small Systems 

You can install all OSIsoft PI System software components and the SETPOINT CMS software on a 
single stand-alone computer.  Refer to the PI Asset Framework Installation and Upgrade Guide for 
installation information.  The SETPOINT CMS dynamic data collection creates data much faster than 
for standard process points so the number of dynamic data points is much lower than the number of 
standard process points that OSIsoft specifies.  Brüel & Kjær Vibro recommends a computer with a 
minimum of: 

• Windows Server 2008 or Windows Server 2012 

• Use SQL Server Express edition or higher 

• 16 GB RAM 

• 1 TB storage minimum 

• Minimum 8 processor cores (12 recommended) 

Limit the total dynamic channel count to 300 channels or less.  A dynamic channel is any channel that 
collects synchronous or asynchronous waveforms as listed in Table 1. 

2.2 Using an Existing PI Server 

If you are already using OSIsoft’s PI System, you can use your existing PI Server provided that: 

• You have PI Server version 2012 or later. 

• PI Asset Framework 2012 SP2 or later. 
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2.3 Large Systems 

For systems with more than 10,000 assets, and moderate-to-high workloads and point counts, 
OSIsoft recommends that you:  

• Install Microsoft SQL Server on a separate computer from PI Server.  

• Install PI AF server on either the PI Server or SQL Server computer.  

• Use Microsoft SQL Server Standard or Enterprise edition instead of Express edition.  

For best performance and improved security, OSIsoft recommends that you install SQL Server on a 
different computer from PI Server.  OSIsoft also recommends at least two physical drives on the PI 
Server computer. 

2.4 Other Installation Deployments 

The PI Asset Framework Installation and Upgrade Guide discuss other installation deployments 
including high availability designs.   

2.5 CMS Display Computer 

When running the CMS Display application on a separate computer from the servers, the computer 
should have at least 4 GB RAM and a 3rd Generation Core Intel processor or equivalent.  

You also can run the CMS Display on the server computer and connect remotely.  Your server will 
need a graphics card supporting Shader Model 3 and Direct X 9 to support CMS graphics. 

2.6 Uninterruptable Power Supply (UPS) 

Your PI Server must be installed with a UPS wired for graceful shutdown in the event of a main power 
loss.  An unexpected loss of power can prevent the server from restarting normally when power is 
restored, resulting in data loss. 

 

 

APPLICATION ALERT! 
Unexpected loss of server power can result in loss of data.  Use an uninterruptable power 
supply configured to gracefully shut down the server on power loss 
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2.7 Time Synchronization 

SETPOINT CMS will automatically synchronize the VC-8000 rack system time with the PI Server 
computer time.  These synchronization commands occur when the Setpoint-PI Adapter 
communication to the rack is started and once per day after that.  Synchronization is typically to within 
1 second.  Alternatively, you can configure the VC-8000 Setpoint rack for NTP time synchronization.  
Refer to the VC-8000 Operation and Maintenance manual S1079330.  NTP is capable of time 
synchronization to the millisecond level depending on the network architecture.  Table 7 lists the 
network ports that the system uses for time synchronization.  When configured for NTP, the VC-8000 
rack will ignore time synchronization requests from the Setpoint-PI Adapter or other sources. 

2.8 Protection from Network Failures 

Referring to Figure 1 and Figure 2, the VC-8000 system has multiple levels of data buffering and 
storage to guard against data loss in the event of network interruption. 
 
Data storage can be volatile, where store information is lost on power failure or system reset, or non-
volatile where the information is stored on an SD card or Solid State Drive that will retain the data on 
a power failure or system reset. 
Table 3 lists where the data is buffered, what network interruptions are backed up, and the amount of 
data or time duration that the interruption can last before data loss. 
Table 3: Network Data Buffering 

Buffering 
Location Description Amount 

UMM The UMM stores static and waveform data internally during 
periods of rapid machine changes or for protection against 
temporary communication interruption with the SAM such 
as during a SAM firmware upgrade or major configuration 
change.  Volatile 

3600 waveforms.  Quantity is across 
all channels but is not allocated per 
channel (e.g. an interesting channel 
can store more waveforms than non-
interesting channels. 

SAM Internal data buffer used to hold data until it can be spooled 
to the PI System, XC, or the internal SD or HD.  Provides 
protection against loss of data during short network 
interruptions between the rack and the Setpoint PI Adapter 
or loss of data while changing the SD card.  Volatile. 

5 minutes typical waveform and 
static data storage. 

HD Internal solid state drive (SSD) data storage.  System can 
be configured to automatically backfill data from the HD to 
PI in the event of network interruption between the rack and 
the Setpoint-PI Adapter.  Non-Volatile. 

Depends on HD option purchased:  
32 GB, 256 GB, or 480 GB. 

SD Data is stored on the SD card.  Backfilling from the SD card 
is a manual process.  SD is an alternative to the HD to 
provide protection against network interruption between the 
rack and Setpoint-PI Adapter.  See Section 14.  Non-
Volatile. 

Depends on SD card size.  
Maximum is 32 GB. 

PI 
Buffering 

PI Buffering stores data in the case of communication loss 
between the Setpoint-PI Adapter and the PI Server.  
Recommended when the Setpoint-PI Adapter is located on 
a different computer than the PI Server.  Non-volatile for 
files other than the current file. 

Limited only by available space on 
the drive where the PI Buffering 
folder resides. 
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NOTE! 
When the PI Server and Setpoint-PI Adapter are running on the same computer, PI Buffering 
provides no value and degrades performance.  Turn off PI Buffering for this case. 

When the PI Server and Setpoint-PI Adapter are running on the same computer, turn off PI Buffering 
using the following instructions: 

Locate the PICLIENT.ini file.  This should be located in the C:\Program Files\PIPC\dat folder 

Change the Buffering attribute value to “0” from the default value of “1”. 
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3 SETPOINT CMS Enabled Hardware 

3.1 UMMs and TMMs 

VC-8000 modules must be condition monitoring enabled in order to stream data to the SAM’s internal 
hard drive, SD card drive, and/or a connected OSIsoft PI Server.  Once the data has been stored to 
any of these mediums, it can be viewed with SETPOINT CMS software.   

 

 

NOTE! 
This data stream includes both high-speed static data and dynamic (waveform) data and 
should not be confused with the low-speed static data provided to the DCS port(s) on the 
SAM.  All modules provide data to the DCS NET (Ethernet) and (if present) DCS SER (serial) 
ports on the SAM. Refer to SETPOINT Operation & Maintenance Manual S1079330 for 
additional information on these DCS communication ports. 

CM-ENABLED modules can be identified using the Setpoint Maintenance software Hardware Info 
tab as shown in Figure 3 (Refer to VC-8000 manual S1079330).  Although it is permissible to have a 
rack with a mix of CM and non-CM modules, only the CM-ENABLED UMMs and TMMs will be 
capable of providing any data (whether static or dynamic) for viewing in CMS software.  

 
Figure 3:  Identifying CM-Enabled Hardware 

If you are upgrading an existing rack to support CMS connectivity, UMM and TMM modules may be 
converted to CM-ENABLED versions in the field, without a hardware change.   

In addition to CM-ENABLED UMMs and TMMs, the rack must also have a CM-ENABLED SAM.  If the 
SAM is not CM-ENABLED, its CMS Ethernet port will be disabled and no communications can occur.  
Nor will its SD Card slot or internal hard drive support CMS data. 

 

 

NOTE! 
Even if your eSAM is CM-ENABLED, it must be using revision 3.X firmware or higher.  You 
can check your firmware revision using SETPOINT Maintenance software and apply newer 
firmware if applicable.  Refer to SETPOINT Operation & Maintenance Manual S1079330 for 
additional information. 

The module is CM-Enabled 
if the CMS text is green.  
Otherwise the module is not 
CM-Enabled. 
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3.2 Upgrading SETPOINT Hardware 

You can purchase CMS upgrades for existing hardware and install them locally or remotely.  This 
section lists the basic steps to follow to obtain CMS enabler keys. 

Use the Hardware Info screen from the front panel or the SETPOINT Maintenance software: 

 

 
Figure 4:  Retrieving the Hardware Information 

*If the Supported Features column lists the feature but it is not green, the hardware is capable of 
supporting the feature but it is not enabled.  If the feature does not show up in the list, the hardware 
does not support the feature. 

The modules must also have the required firmware revision to support the features.  Firmware 
upgrades are available at http://www.setpointvibration.com/downloads/firmware/view. 

UMMs and TMMs require firmware revision 3.0 or higher for CMS functions.  The following table lists 
the required SAM and Front Panel firmware revision by function: 
Table 4 :  SAM Firmware Revision for Function 

Function Required Firmware 
Revision 

CMS with PI-AF 3.0 or higher 

CMS SD 4.02 or higher 

CMS HD 5.0 or higher 

CMS XC 3.0 or higher 
 

Send the diagnostics file to Brüel & Kjær Vibro.    Brüel & Kjær Vibro will return a .setk file with 
enabler keys for your hardware. 

  

1) Click Hardware Info 
2) Check the supported 

features.* 
3) Save the Diagnostics 

File. 

http://www.setpointvibration.com/downloads/firmware/view
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Use the SETPOINT Maintenance software to apply the enabler keys. 
 

 
Figure 5: Enabling Hardware Features 

Navigate to the .setk file and click Open. 

 

 

NOTE! 
Each set of keys is specific to a module and may not be moved between modules.   

 

 

From the Firmware Upgrade 
View, click the Enable Hardware 
button to open a dialog for 
selecting the enabler key file. 
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4 Software Licensing 

4.1 SETPOINT CMS Display Licensing 

SETPOINT CMS Display software is provided free-of-charge and may be downloaded from our 
website.  The license agreement is displayed during the installation process for this application and 
the user must accept this license in order to proceed with the installation. 

4.2 SETPOINT-PI Adapter Licensing 

The SETPOINT-PI Adapter software converts the data stream from the CMS port on the SAM into a 
format readable by a PI Server.  It functions similar to a PI Interface.  This software incurs a charge 
and cannot be downloaded from our website or freely distributed.  It will be provided to you by Brüel & 
Kjær Vibro via physical media and/or a special download site.  Once provided to you, it may be 
installed on as many computers as required for a single site, but normally only a single instance of 
this application is required for each PI Server.  The license agreement is displayed during the 
installation process and the user must accept this license in order to proceed with the installation.  

4.3 OSIsoft PI System Licensing 

Necessary OSIsoft PI System components for SETPOINT CMS can be obtained directly from 
OSIsoft, or from Brüel & Kjær Vibro.  When purchased from Brüel & Kjær Vibro, the license 
agreement is between the end user and Brüel & Kjær Vibro and consists of doc 1313253 along with 
the Brüel & Kjær Vibro customer order number.  All software support comes directly from Brüel & 
Kjær Vibro in such situations.   

When PI System components are purchased from OSIsoft rather than from Brüel & Kjær Vibro, the 
license agreement is between the end user and OSIsoft, and document 1313253 does not apply.  
Support for the PI Server and other PI System components in this situation comes from OSIsoft.  
However, support for the SETPOINT hardware, SETPOINT-PI Adapter software, and SETPOINT 
CMS Display software comes from Brüel & Kjær Vibro. 

4.3.1 PI System Tags    

4.3.1.1 SETPOINT-supplied tags 

A single measurement variable in the PI System is known as a tag.  SETPOINT UMMCM and TMMCM modules 
can supply multiple measurements, including waveforms, and may thus consume several dozen tags per channel 
(refer to  

Table 6), depending on the channel type and configuration.  When a PI System is provided by Brüel & 
Kjær Vibro as part of a CMS installation, tags for each UMMCM and TMMCM module are included using 
SETPOINT p/n SWT-05 for UMMCM and SWT-06 for TMMCM.  These part numbers cover an entire 
module (not a channel or a single measurement variable) by providing the requisite number of tags 
for any possible combination of channel types/configurations in the module.  The licensing agreement 
for these tags is encompassed by document 1313253 and the Brüel & Kjær Vibro customer order 
number.  These tags are restricted to use only with SETPOINT data streams.   
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They are not to be used for measurements originating outside of your SETPOINT racks, except as 
noted in 3.4.1.2 below. 

4.3.1.2 Process data tags 

PI Servers provided by Brüel & Kjær Vibro are licensed for an additional 250 tags beyond those 
consumed by data originating in the SETPOINT rack(s).  These additional 250 tags are intended for 
process variables pertaining to the machine(s), but which do not originate in the SETPOINT rack(s).   

Examples include motor winding temperatures, generator loads, lube oil 
temperatures/flows/pressures, or compressor suction and discharge temperatures/flows/pressures 
that may come directly into a PLC or DCS.  Such points can be supplied to the PI Server via a PI 
Interface using the appropriate protocol rather than via hardwiring through a SETPOINT rack.  This 
licensing ensures that adequate tags are available for this supplementary machinery data, while 
restricting customers from using their Brüel & Kjær Vibro -supplied PI Servers as general-purpose 
process historians.  Customers requiring more than 250 process data tags can work with OSIsoft to 
convert their Brüel & Kjær Vibro PI Server to an “unrestricted” PI Server and secure any incremental 
necessary tags. Contact Brüel & Kjær Vibro for additional details. 

4.3.1.3 Customer-supplied tags 

When you use your existing PI Server with tags purchased directly from OSIsoft, the license 
agreement for your PI Server and tags is with OSIsoft.  These tags are not restricted in how they may 
be used, except as governed by your OSIsoft license.  They can be used for SETPOINT and non-
SETPOINT datastreams, in any combination.  However, in order to access this data once in the PI 
Server and display it with CMS Maintenance software, a PI Server Access (PSA) license is required 
as discussed in 3.4.2. 

4.3.1.4 Tag Requirements 

Table 5 shows the number of tags required for SETPOINT CMS.  To calculate the total number of tags, use the 
SETPOINT Setup application and count the total number of measurements as seen on the Measurement View 
and the total number of waveforms as seen in the Waveform Configuration View.  Then multiply these by the 
values shown in Table 6. 

Table 5: PI System Tags Required 

Use Tags Required  Notes 

Adapter Service 1 One required per Adapter Service computer 

Rack 1 For each rack  

Measurement and Status 2 Per measurement 

Waveform and Status 2 Per Synchronous or Asynchronous waveform 

Waveform Interestingness  Index 1 Per channel 
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Table 6: Tags Required by Channel Type 

Universal Monitoring Module 

Channel Type 

PI Tag Consumption Data Returned 
Measurements 

Available Waveform1 Non-WF 

Max Min Typical Sync Async Static2 
Accel – Std 23 4 17 ● ● ● 9 

Accel – Env 19 14 19 ● ● ● 7 

Accel – Aero 13 6 13 ● ● ● 4 

Accel – LF Intg 11 4 9 ● ● ● 3 

Accel – REB 11 8 11  ● ● 4 

Accel -  REB slow 11 8 11  ● ● 4 

Acoustic 23 20 23  ● ● 10 

Axial Pos’n 9 4 7   ● ● 3 

Axial Pos’n sync 11 4 9 ● ● ● 3 

CE – Single 2 2 2     ● 1 

CE – Dual 6 6 6     ● 35 

DE 4 4 4     ● 2 

CIDE 10 10 10     ● 55 

RDE 10 10 10     ● 55 

Discrete 2 2 2     ● 1 

Dyn. Pres. 15 4 9 ● ● ● 5 

Ecc 15 10 15 ● ● ● 5 

Impact 11 6 11 ● ● ● 3 

Phase Trig 11 4 7   ● ● 4 

Process Var 4 4 4     ● 2 

REBAM 11 8 11  ● ● 4 

RV-Std 25 4 17 ● ● ● 10 

RV -  Air Mach 21 8 21 ● ● ● 8 

RV – Hydro 29 20 29 ● ● ● 12 

Shaft Abs 38 12 38 ● ● ● 105 

Rev. Rot’n 20 14 20   ● ● 75 

Tachometer 4 4 4   ● 2 

Valve Pos’n 4 4 4     ● 2 

Vel – Std 23 4 17 ● ● ● 9 

Vel – Aero  11 6 11 ● ● ● 3 

Vel- Hydro 29 20 29 ● ● ● 12 

Vel – LF Intg 9 4 9 ● ● ● 2 

Zero Speed 15 10 13   ● ● 75 

Temperature Monitoring Module 
Temperature 6 2 2     ● 3 

Process Var 2 2 2     ● 1 

Rack3 
System4 
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Notes: 

1. Waveform Data Tag Consumption   
2 tags for each sync waveform per channel 
2 tags for each async waveform per channel   
1 tag for interestingness index per channel (waveform-capable channels only) 
 
2. Static Data Tag Consumption   
2 tags for each measurement (1 for value, 1 for status)  
 
3. Rack Tag Consumption   
1 tag per rack   
 
4. System Tag Consumption SETPOINT-to-PI adapter  
1 tag per adapter   
 
5. Denotes configuration selection that uses two sensors and consumes two UMM 

channels.   
Measurement count is combined total for channel pair.  If sync and/or async waveforms are 
indicated as available, they are available from each channel individually. 
 
6. Channels Not Listed 
For channels not listed, use the Setpoint Setup software to view the number of active 
measurements.  Multiply the number of active measurements by 2 and add to total according to 
note 2. 

Example: 

A system with one adapter service connected to 3 racks.  Each rack is collecting 96 measurements 
and 32 waveforms from 16 channels. 

Total Tags = (1 tag x 1 Service) + (1 tag x 3 Racks) + (2 tags x 96measurements x 3 racks) + (2 tags 
x 32 waveforms x 3 racks) = 772 tags  

4.3.2 PI Server Access (PSA) License    

Brüel & Kjær Vibro -supplied PI Servers 

When a PI Server is supplied by Brüel & Kjær Vibro, it is licensed to connect to any other applications 
provided by OSIsoft, including but not limited to PI Interfaces, PI-to-PI Interfaces, ProcessBook, 
Vision, and DataLink.  It is also licensed to connect to SETPOINT CMS Display software and the 
SETPOINT-PI Adapter Software.  It is not licensed to connect to any other third-party applications.  
For other third party applications to access the data in a Brüel & Kjær Vibro -supplied PI Server, a 
PSA is required.  Contact Brüel & Kjær Vibro for additional information. 
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OSIsoft-supplied PI Servers 

When a PI Server is supplied by OSIsoft, it is licensed to connect to any other OSIsoft software.  
However, to connect to third-party applications, including SETPOINT CMS Display software and the 
SETPOINT-PI Adapter software, a PSA is required.  An unrestricted PSA, encompassing any third 
party application, may be obtained directly from OSIsoft.  A special SETPOINT PSA, covering only 
SETPOINT-PI Adapters and SETPOINT CMS Display software, is available from Brüel & Kjær Vibro.  
The SETPOINT PSA is typically used when the customer wants to license one or more existing 
OSIsoft-supplied PI Servers for use with SETPOINT datastreams and SETPOINT CMS Display 
software.    

4.3.3 PI Asset Framework (AF) Client License    

SETPOINT CMS Display software requires that PI AF Client software be installed on the same 
computer in order to read data from a connected PI Server.  PI AF Client is not required when CMS 
Display is used to open .cms files rather than connecting to a PI Server.  During the installation of 
CMS Display software, the presence or absence of AF Client will be detected.  If PI AF Client is 
absent, the user will only be able to open and view .cms files.  If PI AF client is present, the user will 
also be able to connect to a PI Server containing SETPOINT CMS datastreams. 

4.4 SD Card and Internal SAM Hard Drive Installations 

When SETPOINT data will not be streamed to a PI Server, and instead streamed to the SAM’s SD 
Card or internal hard drive, no PI System components are required and no PI System licensing is 
necessary.  The only CMS software required is the SETPOINT CMS Display, with the features 
enabled per Section 3. 
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5 Installation 

5.1 Installing the PI System 

Refer to the OSIsoft PI System installation manuals when installing the OSIsoft PI System 
components.  The recommended installation order is: 

1. SQL Server (for the PI AF Database) 
2. PI AF Server 2012 or newer 
3. PI Server 
4. PI AF Client 2012 or newer 
5. Reboot the Server 

 
 
 
 

5.2 Installing the SETPOINT-PI Adapter 

Click on the Setpoint_PI_Adapter_Setup.exe to install the SETPOINT-PI Adapter and configuration 
application.  Accept the license agreement and follow the instructions shown on the screen. 

 

 

APPLICATION ALERT! 
Server OS upgrades can cause the server to restart resulting in loss of data.  Turn automatic 
updates off to prevent data loss. 

 
 

 

NOTE! 
The computer running the SETPOINT-PI Adapter must also have the PI AF Client application 
installed. 
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During the install process you will be prompted to enter Log On Credentials for the SETPOINT-PI 
Adapter Service as shown in Figure 6.  If the PI Adapter Service is installed on the same computer as 
the PI Server and PI AF Server, you can select Run service as a Local System.  If not, fill in an 
Administrator Account and password or other user with PI AF server write access logon information.  
Click the Test Credentials button to verify the Account and Password are valid. 

 

 

NOTE! 
When setting the account and password it is best to use an account whose password will 
never change; be aware that when account passwords change, the service password must 
also be updated. 

 

 
Figure 6: Setting the Adapter Service Log On Credentials 

 

5.2.1 Changing the SETPOINT-PI Adapter Log On Credentials 

If you need to change the log on account or password, or if you move the PI Server, PI AF Server, or 
Setpoint PI Adapter to a different computer and need to use different credentials, you can change the 
log on credentials using the following instructions.   To change the account or password used for the 
Setpoint-PI Adapter service, change the Log On properties of the Setpoint-PI Adapter service. 
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If the service fails to start, check the Windows Event Log for messages relating to Setpoint-PI 
Adapter. 

 

2.  Select Setpoint-PI Adapter from the 
list of services. 

3.  Right Click and select Properties. 

1.  Open Windows Services 

4.  A dialog will open where you can 
change the account and password. 
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5.3 Installing the SETPOINT CMS Display Application 

Click on the Setpoint_CMS_Setup.exe to install the CMS application.  Accept the license agreement 
and follow the instructions shown on the screen. 

 

 

NOTE! 
The computer running the SETPOINT CMS Display Application must also have the PI AF 
Client with SP2 (or higher) application installed. 
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6 Security  

This section describes the minimum security configuration for Setpoint CMS operating with a PI 
Server.  This includes: 

• Setting User Permissions 

• Opening Firewall Ports 

The PI System provides many additional security features.  Refer to the OSI document PI Server 
Configuring Security. 

6.1 Setting User Permissions 

The OSIsoft PI System has security methods to protect against unauthorized writing, reading, or 
changing data in the databases.  You can set access permissions by user following the OSIsoft 
procedures.  If you have an existing OSIsoft PI System, your system administrator will need to set up 
the permissions.  Brüel & Kjær Vibro Service can also provide assistance in setting up security 
access. 

Users will need Write/Change permission in order to: 

 

• Change Reference Data or Overlays 

• Store Reference Data 

• Change Bearing Clearance 

• Change Reciprocating Compressor Gas Properties 

To set user permissions for simple systems or for quick implementation, follow the instructions in this 
section.  Start by opening the PI System Management Tools. 

 

Expand Security in the tree and select Mappings & Trusts.  Assign users to the PI System database 
as shown: 
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Figure 7: Adding Users 

Referring to Figure 8, fill in the Windows Account for the new user.  The Windows SID will fill in 
automatically.  The Description is not required and can be left blank.  The PI Identity sets the access 
level for the PI Server.  Consult with your PI Administrator for the appropriate PI identity for the new 
user.   

 
Figure 8: Add New Mapping Dialog 

 

 

NOTE! 
The server computer must be connected to the same network domain as the users you are 
adding.  

2.  Expand Security tree and select 
Mappings & Trusts. 

3.  Click New User to open the Add 
New Mapping dialog. 

1.  Connect to the Server. 



 

Page 32 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

 

 

NOTE! 
Though you can map individual users to PI identities, it is not a recommended practice.  OSI 
recommends using Domain Groups to manage access.  Refer to the OSI document PI Server 
2012 Configuring Security for best practices when creating and mapping Domain Groups. 

 

6.2 Opening the Firewall Port on the Server 

If you are running a firewall on your Server, you will need to open the ports used by the SETPOINT 
CMS SETPOINT-PI Adapter Service.  These ports are required: 

 

Table 7:  Communication Ports 

Port Description 

8001 
Communication and time synchronization between the VC-8000 rack and the 

SETPOINT-PI Adapter.1 

8002 
Communication between the CMS Display Application and CMS-XC computer.  Only 

required when using the CMS-XC option. 

8003 
Communication between the CMS Display Application and the CMS-HD enabled rack.  

Only required when using the CMS-HD option.1 

8004 
Communication for Remote-Access Configuration between MPS-Software a VC-8000 

Rack. Only required when using MPS-Remote option. 

5450 PI AF Client to PI Server 

5457 PI AF Client to PI AF Server 

137, 138, 139, 88 AF Server to Domain Controller 

UDP 123 NTP Time Synchronization 

1 These ports should only be open for internal firewalls and are not intended to be open on firewalls to 
external networks. 

 

 

NOTE! 
The PI System Ports shown are defaults.  Verify that you have opened the ports your PI 
System is configured to use. 
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Change the Firewall Ports from: 

Control Panel -> System and Security -> Windows Firewall as shown below. 

 

 
Figure 9:  Windows Firewall Configuration 

 

 
Figure 10:  Windows Firewall Advanced Security 

Choose Advanced settings. 

1. Click  Inbound Rules. 
2. Select New Rule. 
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Figure 11:  Setting the Rule Type 

 
Figure 12:  Specify the Port 

Check  Port. 

Check TCP. 
 
Enter the port number 
to open. 
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Figure 13: Allow the Connection 

 

 
Figure 14: Setting the Rule Application 

Check Allow the 
connection. 

Check all three. 
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Figure 15:  Setting the Port Rule Name 

You will need to repeat the steps in Figure 11 through Figure 15 creating Inbound and Outbound rules 
for each of the ports shown in Table 7. 
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7 Configuration 

You will need to configure your SETPOINT system for proper operation.  Configuration includes: 

• Configuring the SAM CMS (DAC) network settings 

• Configuring the machine asset hierarchy 

• Configuring the waveform collection parameters 

• Configuring the SETPOINT-PI Adapter to connect to the VC-8000 rack and PI AF Server. 

• Configuring PI AF System Explorer 

7.1 Configuring the SAM 

Use the SETPOINT Setup software to configure the VC-8000 rack.  Refer to the VC-8000 Operation 
and Maintenance Manual S1079330.   

7.1.1 Configuring the SAM Network Settings 

This section describes how to configure the SAM network settings for communication with a PI 
System. 

The SAM uses the CMS (DAC) Ethernet port to communicate condition monitoring data to a PI 
System.  You must set the SETPOINT Ethernet network communication parameters to be compatible 
with your data acquisition computer and network.   

 
Figure 16: Opening the SAM Properties 

Highlight the SAM row and then click 
the properties tab. 

Check CMS (DAC) Enabled, set the 
CMS (DAC) Rack Name, and set the 
CMS (DAC) IP information. 
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Set the parameters below.  Other parameters shown are for the SAM Modbus communication and are 
discussed in the VC-8000 Operations and Maintenance Manual. 

CMS (DAC) Rack Name 

Assign a name to the VC-8000 rack.  The SETPOINT-PI Adapter uses this name when creating 
unique tags in the PI database.  Each rack must have a unique name. 

 

NOTE! 
If you change the rack name the Setpoint-PI Adapter will allocate new PI Tags.  Use the 
Rack Alias (See Section 8.2 and 8.4) setting to avoid creating new tags if you change 
the rack name. 
 

CMS Enabled 

Check this box to turn on the CMS (DAC) Ethernet port for connection to CMS (PI System or CMS-
XC) 

CMS-SD Enabled 

Check this box to turn on recording to the SDcard.  The SAM must be have been purchased with the 
SD card capability to activate this feature. 

CMS-HD Enabled 

Check this box to turn on recording to the internal drive.  The SAM must be have been purchased 
with the SD card capability to activate this feature. 

CMS IP Address 

The Internet Protocol (IP) address is used by the Ethernet switching equipment to route packets.  
Each device on a network subnet must have a unique IP address.  Consult your network 
administrator for a static IP address. 

The default IP address is 192.168.0.2. 

SETPOINT only uses static IP addresses.  DHCP (dynamic address assignment) is not supported. 

CMS Subnet 

The subnet mask is used to identify the IP address bits that define a subnet.  Consult your network 
administrator for a valid subnet mask. 

The default subnet mask is 255.255.255.0.   
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CMS (DAC) Default Gateway 

The default gateway is the address used when a client resides on a different subnet.  Typically the 
default gateway is the address of a router used to route packets between the subnets.  Consult your 
network administrator for a valid default gateway IP address. 

CMS Collect Diagnostics 

The SETPOINT CMS system collects diagnostics and statistics on data storage and bandwidth 
usage.  Checking this option causes the SETPOINT-PI Adapter to create PI tags and store the 
diagnostic values in the PI system. 

 

 

NOTE! 
The diagnostics will consume 22 PI tags for each rack.  Be sure you have enough PI tags 
available when selecting this option. 

 

7.1.2 Configuring the SAM CMS Data Storage 

The SAM, when licensed, can store CMS data in several different ways: 

 

• CMS SD:  Stores data on a Secure Digital (SD card) up to 32 GB 

• CMS HD:  Stores data on an internal solid state drive up to 256 GB 

• CMS XC or DAC:  Spooled to an external computer for storage on an OSIsoft PI Server or on 

an external drive 

 

Enable these by checking the box in the SAM Properties: 
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7.2 Configure the Machine Asset Hierarchy 

The PI Asset Framework imports your plant and machine hierarchy from the VC-8000 rack.  Use the 
SETPOINT Setup software to configure the hierarchy by opening the Asset Framework View from 
the Channels View as shown in Figure 17. 

 

  
Figure 17: Opening the Asset Framework View 

Configure the parameters described below from the Asset Framework View (Figure 18). 
 

 
Figure 18: The Asset Framework View 

 

1.  Select the Channels View. 
2.  Select Asset Framework from the 
drop list. 
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Asset Path 

The asset path provides a method for creating an asset hierarchy in PI AF.  You can view the 
hierarchy using PI System Explorer as shown in Figure 19.   

The backslash (\) separates the asset levels. 

The asterisk (*) following a level determines where the Asset Path will be truncated when displayed 
on the home screen. 

Example: 

An asset path set to Alky*\Compressor 65CC201\ would create two levels:  

+ Alky 

          + CompressorCC201 

“Alky” would appear at the top asset level.   

The hierarchy appears in the PI System Explorer: 

 

 
Figure 19: PI System Explorer Hierarchy 

In this case the asset path was entered as: 

Minden\Unit 501\B4 
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7.3 Configure Data Collection Rates 

Data collection rates are set on the Asset Framework View.  This section describes how to set these 
parameters. 

7.3.1 Dynamic Collection Rate (Minutes) 

The dynamic collection rate sets the maximum amount of time that can elapse between storing the 
most interesting waveform.  The dynamic collection rate ensures that waveforms are collected 
periodically, even when the machine condition is not changing enough to trigger the dynamic 
collection % change threshold. 

Whenever the dynamic collection rate time elapses, SETPOINT CMS stores the waveform that has 
changed the most during the collection interval.  Worst case, the maximum time between stored 
waveforms can be twice the Dynamic Collection Rate. 

Setting a short dynamic collection rate can cause the SETPOINT CMS to collect very large amounts 
of data as shown in Table 8.  SETPOINT CMS will automatically collect and store more waveforms 
during transient conditions so the dynamic collection rate does not need to be set low to achieve good 
waveform collection when the machine state is changing.   
Table 8: Dynamic Collection Rate Data Storage for 2048 Sample Waveforms 

Dynamic 
Collection 

Rate 
Data Stored for 1 Channel over 1 

Year 
 

Data Stored for 300 Channels over 1 
year. 

1 minute 25.8 GB 7.7 TB 

20 minutes 1.3 GB 390 GB 

2 hours 216 MB 65 GB 

1 day 18 MB 5.4 GB 

 

 

NOTE! 
Data collection during transient operation can be much higher than steady state.  Size your 
hard drive space accordingly. 

 

For reference, a machine startup collecting sixty 2048 point waveforms would require approximately 
1.8 MB for each channel associated with a phase trigger and 0.9 MB for each channel not associated 
with a phase trigger. 
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7.3.2 Dynamic Collection % Change Threshold 

The SETPOINT monitor will freeze a dynamic waveform sample when any of the measured variables 
change by the configured % of the danger setpoint.  If there is no danger alarm set, the monitor uses 
the percentage of the configured full scale.   

Example:   
The configured radial vibration danger alarm is 4 mils pp 
The current vibration level is 1.5 mils pp. 
The Dynamic Collection % Change Threshold is 3% 
If the data value changes by 0.12 mils pp (3% of 4 mils pp) then the UMM will collect a dynamic 
waveform.  This will occur in either direction, if the amplitude increases to 1.62 mils pp or drops to 
1.38 mils pp. 

7.3.3 Adaptive Interestingness 

Adaptive interestingness (i-ness) is a tool that learns the machine changes and automatically adjusts 
the Dynamic Collection % Change Threshold to increase or decrease waveform collection.  For 
example, if the system detects that the machine routinely changes vibration levels by 4% during 
normal operation, adaptive i-ness will increase the dynamic collection % change threshold greater 
than 4% to prevent the system from collecting excessive waveforms.  The adaptive process learns 
the operation over a period of time so that sudden changes will always initially be interesting and 
drive for high data collection.  The data collection will gradually slow down as the condition persists. 

 

 
Figure 20: Enabling Adaptive I-ness 

Adaptive interestingness is enabled by default on dynamic channels and is recommended for long 
term data collection.   

7.3.4 Dynamic Collection on Speed Change 

The speed of an associated Phase Trigger is also included in the determination of when to collect 
dynamic data.  Set the speed change interval on the Channel Asset Framework View as shown in 
Figure 21.  You can set different delta RPM intervals regardless of whether the channels are using 
the same Phase Trigger or not. 

Clear or check the Enable Adaptive I-ness 
button to disable or enable the adaptive 
interestingness function. 
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Figure 21: Setting Speed Change for Dynamic Data Collection 

 

 

NOTE! 
The Delta RPM value causes the monitor to collect dynamic waveform data at this interval.  
Static data collection is independent.   There is not a fixed ratio between static and dynamic 
data collection.   

  

Set the speed interval for dynamic data 
collection at the Delta RPM column on the 
Asset Framework View. 
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7.4 Configuring Waveform Collection Parameters 

SETPOINT CMS uses configuration information that is set in the SETPOINT Setup application when 
the VC-8000 is configured.   

 

 

NOTE! 
If you created your rack configuration with SETPOINT Setup software older than version 3.0, 
you will need to manually add in the waveforms.  Refer to the VC-8000 Operations and 
Maintenance manual for information on adding measurements. 

 

7.4.1.1 Channel Pairs for Orbits 

Channel pairs are fixed as channels 1 and 2 or channels 3 and 4 on a UMM.  The configured 
transducer’s orientations determine which channel is “X” and which is “Y”. 

7.4.1.2 Setting sample rates 

Follow the instructions in this section for setting the waveform sample rates.   
 

 

CAUTION! 
The SETPOINT Setup Software resets the monitors after configuration which can interrupt 
machine protection. 

 

Enter the Waveform Configuration View from the Measurements View as shown in Figure 22. 

 
Figure 22: Entering the Waveform Configuration View 

  

1.  Go to Measurements View. 
2.  Select Waveform from the drop list. 
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7.4.1.3 Configuring Synchronous Waveforms 

Synchronous Waveform data collection is configured in terms of the number of samples collected per 
shaft revolution, evenly spaced in phase.  Higher sample rates give better Orbit and Timebase 
resolution but more coarse resolution for spectrums displayed in orders.  More samples (or 
revolutions) take longer to collect and provide greater spectrum resolution.   
Table 9: Synchronous Sampling Configuration 

Rate Maximum 
Speed 

Number of 
Samples Revolutions 

Spectrum Range, 
Resolution 

Collection time 
at 3600 rpm 

128X 12,500 rpm 
1024 8 50X, 0.125X 133 ms 

2048 16 50X, 0.0625X 267 ms 

64X 25,000 rpm 
1024 16 25X, 0.0625X 267 ms 

2048 32 25X, 0.03125X 533 ms 

32X 50,000 rpm 
1024 32 20X, 0.03125X 533 ms 

2048 64 10X, 0.015625X 1.07 s 

16X 100,000 rpm 
1024 64 5X, 0.015625X 1.07 s 

2048 128 5X, 0.0078125X 2.13 s 

 

The collection time is dependent on speed.  The software shows the data collection time for a 
machine running at 60 Hz (3600 rpm).  You can estimate the data collection time for your machine 
speed by multiplying the time shown by 3600 rpm and dividing by your machine speed in rpm. 

 

 

NOTE! 
Reciprocating Compressor channels support higher synchronous sample rates.  Refer to the 
Reciprocating Compressor Manual. 

 

7.4.1.4 Configuring Asynchronous Waveforms 

You can change the asynchronous sample rate and number of samples collected to optimize your 
spectrum display.  Remember, as the number of lines increases, the amount of time it takes to collect 
the spectrum increases.  If the machine speed is changing, this can cause smearing of the spectrum. 
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Table 10: Asynchronous Sampling Configuration 

Sample 
Rate  

 

Span Number of  
Samples 

Spectrum 
Lines 

Resolution Time to 
Collect 

256 sps 100 Hz 1024 400 0.25 Hz, 15 cpm 4 s 

 2048 800 0.125 Hz, 7.5 cpm 8 s 

512 sps 200 Hz 1024 400 0.5 Hz, 30 cpm 2 s 

 2048 800 0.25 Hz, 15 cpm 4 s 

1280 sps 500 Hz 1024 400 1.25 Hz, 75 cpm 0.8 s 

 2048 800 0.625 Hz, 37.5 cpm 1.6 s 

 1000 Hz 1024 400 2.5 Hz, 150 cpm 400 ms 

2560 sps 2048 800 1.25 Hz, 75 cpm 800 ms 

 2000 Hz 1024 400 5 Hz, 300 cpm 200 ms 

5120 sps 2048 800 2.5 Hz, 150 cpm 400 ms 

12800 sps 5000 Hz 1024 400 12.5 Hz, 750 cpm 80 ms 

 2048 800 6.25 Hz, 375 cpm 160 ms 

25600 sps 10000 Hz 1024 400 25 Hz, 1500 cpm 40 ms 

 2048 800 12.5 Hz, 750 cpm 80 ms 

51200 sps 20000 Hz 1024 400 50 Hz, 3000 cpm 20 ms 

 2048 800 25 Hz, 1500 cpm 80 ms 
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7.4.1.5 Deleting a Waveform 

By default, SETPOINT CMS collects waveforms on all configured channels.  To save space in the 
database, you may want to turn off data collection for some waveforms.  Figure 23 shows how to 
remove a waveform from data collection. 

 
Figure 23: Deleting a Waveform 

 

7.4.1.6 Adding a Waveform 

If you decide to restart waveform collection for a deleted waveform, follow the steps below to add the 
waveform to the data collection. 

To add a waveform, click the Add button on the Measurement Configuration View.  Click the 
monitor module, and then the channel.  A list of available added measurements will appear as shown 
in Figure 24 

 
Figure 24:  Adding Measurements 

The new waveform will appear in the Waveform Configuration View as shown in Figure 22. 
 

1.  Click on the left box to select the 
waveform line. 
2.  Press the Delete button to delete the 
waveform. 

Clicking the Add button 
opens a list of channels 
and measurements you 
can add. 
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7.5 Boost Mode and Compression Configuration 

The VC-8000 rack contains high speed memory for continuously sampling and recording dynamic 
waveform data during fast transient events.  This function provides a rich dataset even for machines 
that start up or coast down in seconds and results in superior plots when compared to systems that 
take waveform snapshots during transients.   

 

 

NOTE! 
Use boost mode for machines that change speed for less than 2 minutes (not including soak 
time).  For machines that ramp slower, standard sampling will provide a good data set. 

 
 

 

NOTE! 
You must assign a phase trigger to the channel to use boost mode.  Channels that do not 
support phase trigger assignments currently do not support boost mode. 

 

A channel enters boost mode when the measured speed is between the high and low trigger speeds 
and the speed is changing by at least one configured delta rpm interval.  A channel exits boost mode 
when the speed is outside the low and high trigger speeds or a phase trigger speed error occurs.  A 
channel will also stop boost continuously recorded data when the speed is not changing by the 
configured delta rpm interval for 10 seconds.  This suspends the high speed sampling during 
temperature soak intervals.  During the soak interval, SETPOINT will continue to collect waveforms if 
an interesting event occurs. 

If the high speed memory fills before the transient event is complete, SETPOINT will revert to 
standard sampling. 

 

 

NOTE! 
Boost mode collects a large amount of data.  Uploading the data to CMS can take up to 45 
minutes.  SETPOINT will continue to collect data using standard sampling if another transient 
event occurs before the previously recorded data is uploaded. 

 

To enable boost mode, navigate to the Asset Framework View and check the Boost Mode box as 
shown in Figure 25.  Then set the Low Trigger and High Trigger values.  SETPOINT will sample the 
channel continuously when the measured speed is between the low and high trigger values until the 
internal buffers fill.  

Set the Low Trigger to a value greater than expected slow roll value.  The Low Trigger turns off 
boosted data collection when the machine is on turning gear.  If the machine is not slow rolled and 
stops at 0 rpm, set the Low Trigger to 10 rpm. 
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Set the High Trigger to a value below steady state running speed less any normal operation speed 
fluctuations.  The High Trigger turns off boosted data collection when the machine has reached 
steady state.   

 
Figure 25:  Boost Mode Configuration 

 

 

NOTE! 
Even on slower starting machines, enabling boost mode and setting the high and low triggers 
around the critical speeds can provide a richer data set while the vibration is changing rapidly.  
The system will automatically revert to normal sampling if the memory fills. 

 
 

 

NOTE! 
If the boost Low Trigger and High Trigger are set to the same value, the system will not enter 
boost mode. 

 

CMS also uses the High Trigger and Low Trigger values to adjust the static data compression 
levels.  When the speed is between the high and low trigger speeds, the machine is in a transient 
condition and the compression levels are reduced.  When outside this range, the machine is assumed 
to be in steady state or slow-roll condition and the normal compression levels (as seen in the PI 
System Management Tools) are applied. 

  

To enable boost mode: 
1. Open the Asset Framework View. 
2. Check the Boost Mode checkbox. 
3. Set the low and high triggers. 
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7.6 Configure PI Database  

The SETPOINT CMS system can create very large amounts of data depending on how often the 
machine conditions change.  You can configure the PI database to use:  A) a fixed number of archive 
files and overwrite, or B) to create new archive files until the storage space fills and then stop.  For 
more information on these, refer to the OSIsoft PI database manuals and tutorial videos.  This section 
gives a brief overview of the storage modes and how they impact SETPOINT CMS data collection. 

7.6.1 Automatic archive creation 

Automatic archive creation is the default with newer versions of the OSIsoft PI database.  As archive 
files fill, the PI system will continue to create new archives of the same size as the primary archive 
until the disk is full.  Default operation is to stop data collection when all storage space is used.  If the 
tuning parameter Archive_AutoArchiveFileRoot shows a path, the system is in automatic archive 
creation mode.  If this parameter is blank, the system is in archive shift mode (see section 7.6.2). 

You can set the PI System to overwrite data (Auto Shift) when the storage space is full by setting the 
tuning parameter Archive_OverwriteDataOnAutoShiftFailure to 1 as shown in Figure 26. 

 

 
Figure 26: PI Database Tuning Parameters 
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NOTE! 
No machine data is saved when all archives are filled and the overwrite parameter is off.  To 
avoid missing critical machine data, set the system to overwrite or periodically monitor the 
available storage space. 

 

 

NOTE! 
The database can overwrite important machine reference data unless configured otherwise.  
Monitor storage space to prevent database wrapping or mark reference archives to prevent 
overwriting. 

 

7.6.2 Archive shift 

In archive shift mode you set up a fixed number of archive files to fill the allocated storage space.  For 
example, if you allocated 10 GB for PI system data, create 100 archives of 100 MB each.  After filling 
all the available archives, the PI System will overwrite the oldest archives.  

 

 

NOTE! 
The database can overwrite important machine reference data unless configured otherwise.  
Monitor storage space to prevent database wrapping or mark reference archives to prevent 
overwriting. 
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8 Configure VC-8000 Rack Connections 

You need to point the VC-8000 rack to the location where it will be storing the data.  The SETPOINT-
PI Adapter Setup software provides an interface for: 

• Configuring data storage locations 

• Adding a new rack 

• Deleting a rack 

• Viewing connection status 

• Starting and stopping data collection 

• View system status logsFigure 35: SETPOINT-PI Adapter 

 

 

NOTE! 
Configure your databases and collection options before adding racks or starting data 
collection. 
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8.1 The Adapter File Tab 

From the SETPOINT Adapter, select the File tab to perform these functions: 

• Select PI AF Servers and Databases 

• Reset Data Compression Settings and update the PI Units of Measure to Match the Rack 

• Configure CMS-XC 

• Access Log Files 

• View the Adapter Version 

8.1.1 PI AF Settings 

PI System to configure OSIsoft PI System data collection. 

 
Figure 27:  Setpoint-PI Adapter PI System Settings 

 
 

 

NOTE! 
If the AF Database configured does not exist, the SETPOINT Adapter will automatic create a 
new database with the configured name. 

 
  

Check the Collect Data 
checkbox to enable data 
storage in the PI System. 
Fill in the PI Server name, the 
AF Server name and AF 
Database name. 
 
To browse for the AF Database, 
click the Select button. 
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8.1.2 CMS-XC Settings 

CMS-XC stores static and dynamic data from the VC-8000 rack into files on a local computer storage 
drive.  CMS-XC files can be directly accessed from the SETPOINT CMS Display Application making 
CMS-XC files suitable for primary data acquisition or for backup to a PI System.  XC is similar to the 
SD card feature but allows the data to be stored on a drive on any computer networked to the rack.   

Refer to Section 12 in this manual for more information on CMS-XC. 
 

  
Figure 28: CMS-XC Configuration 

The Share Data option allows other computers to view live data using the SETPOINT CMS Display 
software.  Clear the Share Data checkbox if CMS-XC is only used for backing up data, otherwise 
check the Share Data checkbox to allow viewing live data.  When the Share Data with CMS Clients 
checkbox is cleared, you can upload the data to the PI System or open the XC database as a file and 
view historical data. 

 

 

IMPORTANT! 
CMS-XC will continue to store data until all available storage space is used.  Brüel & Kjær 
Vibro recommends using a separate partition for CMS-XC data if the computer is also 
performing other important functions. 

 
 
 
 
 
 

The Database Location 
defines where CMS-XC will 
store the data.  Enter a folder 
name or use the Browse button 
to browse to a folder.    

Check the Collect Data checkbox to 
enable CMS-XC data storage. 
 
See notes below on Share Data with 
CMS Clients setting. 
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8.1.3 Options 

The Options view provides several advanced options and maintenance tools: 

• Open the Log Folder 

• Open the Services Dialog 

• Update the Units of Measure (UOM) 

• Reset Compression 

• Upload a CMS database into the PI System 

• Suppress Setting the Rack Time 

• Enable Test Runs 

• Enable Adaptive Exception Deviation 

 
Figure 29: Adapter Options View 

8.1.3.1 Open Log Folder 

The Open Log Folder option opens a Windows folder containing the SETPOINT CMS system logs.  
Use the feature to find log files to send to Brüel & Kjær Vibro for product improvements. 

8.1.3.2 Open Services Dialog 

Clicking this button opens the Windows Services dialog.   You can change settings made during the 
Setpoint-PI Adapter installation from the Services dialog such as the log on account by right clicking 
the Setpoint-PI Adapter service and selecting Properties. 
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NOTE! 
Stopping or resetting the Setpont-PI Adapter service from the Windows Services dialog will 
close the Setpoint-PI Adapter interface and stop data storage. 

8.1.3.3 Updating the Units of Measure (UOM) 

The Update UOM function overwrites the PI System units of measure using the rack configuration 
and the computer location setting.  Use this feature to change unit formats used in different countries. 

 

8.1.3.4 Resetting Compression 

Under normal operating conditions, the Setpoint-PI Adapter only sets the compression levels when 
the PI System tags are first created.  Later changes to the VC-8000 rack channels do not change the 
compression so that any changes made in PI System Management Tools to optimize compression 
are not overwritten.  However, when using the Setpoint rack with different machine assets you may 
need to change compression settings from a previous job.  Click the Reset Compression button to 
return the compression settings to the default settings. 

Reset Compression reverts the PI System compression settings back to the SETPOINT defaults.  
This is important if you have changed channel types within the VC-8000 rack (e.g from displacement 
to velocity) and the compression settings need to change accordingly.   

  

 

NOTE! 
The Reset Compression function will overwrite any manual changes made to the PI system 
compression settings. 

 

8.1.3.5 Upload 

Use the Upload button to import CMS-SD, CMS-HD, or CMS-XC data into the PI System as 
discussed in Section 14. 

8.1.3.6 Suppress Setting Rack Time 

For Brüel & Kjær Vibro Service use.  Leave this cleared for normal operation. 
 

8.1.3.7 Enable Test Runs 

Check Enable Test Runs if you are using the SETPOINT CMS system with one VC-8000 rack for 
different assets as described in Section 19.3 
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8.1.3.8 Adaptive Exception Deviation 

Adaptive Exception Deviation is useful for machines where the signals vary greatly during normal 
operation.  When active, the system will automatically increase the exception deviation threshold to 
limit the amount of data stored.  Brüel & Kjær Vibro recommends activating this feature when using 
the SD card function.  

 

8.1.4 About  

Click About to see the SETPOINT Adapter revision as shown in Figure 30. 

 
Figure 30: Adapter Revision 
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8.2 Adding a New Rack 

Click Add to add a rack to the server.   

  
Figure 31: Adding a Rack in the SETPOINT-PI Adapter 

Enter the Rack IP Address and PI Server name and Root Path as shown in Figure 32 and Figure 33. 
See descriptions of these fields in Table 11. 

 

 
Figure 32:  Setpoint-PI Adapter Rack Settings 

Set the Rack IP Address as set in Section 7.1.1.    The Port field is for information only and is fixed at 
8001.  The CMS-XC Database will cause the system to create new database files using this name at 
the location specified in the CMS-XC configuration (Section 8.1.2). 

Click the Add button to add a new rack. 
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Figure 33: Setpoint-PI Adapter Rack Advanced Settings 

The AF Root Path sets the PI-AF hierarchy.  The Setpoint-PI Adapter appends the asset path set in 
the rack configuration (See Section 7.2) underneath the AF Root Path the first time data collection 
starts.  Once the rack node has been created in PI-AF, changing the Root Path has no effect.  Figure 
34 shows the resulting PI-AF element hierarchy for a rack with AF Root Path of SATA_Temp_Test2 
and a rack name of MACH1. 

 
Figure 34:  AF Root Path 

The Rack Alias is used when creating the PI Tags.  PI tags are created using: Rack 
Alias/Slot/Channel.  If the Rack Alias is not specified, the Setpoint-PI Adapter will create new tags 
using the Rack Name.  You can use the Rack Alias to change the rack name without creating new PI 
tags. 

Refer to section 13.4 for information on PI Backfilling. 
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The following table summarizes the settings: 
 

Table 11: Rack Connection Configuration Parameters 

Setting Description 

Rack IP Address 
 

The VC-8000 System Access Module (SAM) IP Address configured for the SAM CMS 
Ethernet connection. 

Port 
 

The communication port is the Ethernet communication port that CMS is using.  The 
port must be opened through firewalls between the VC-8000 rack and the SETPOINT-
PI Adapter.  Normally you will not change this from the default value. 

PI Server 
 

The PI Server network name or IP Address.  Leave this blank if you are only using 
CMS-XC. 

Root Path 
 

The SETPOINT-PI Adapter appends each channel’s asset path to the root path when 
building the PI AF Hierarchy.  Use the Root Path when the same VC-8000 rack is 
used with different assets such as in test stand or portable diagnostic applications. 

XC Database Specifies the folder name where the Setpoint Adapter will store the XC file data. 

 

 

NOTE! 
The SETPOINT-PI Adapter can resolve PI servers by name (DNS) or by IP Address.  PI AF 
client must be installed on the service computer and the service started before configuring the 
SETPOINT-PI Adapter. 

 

Click OK to keep your changes and to build the hierarchy.  The SETPOINT software will automatically 
upload configuration information from the rack and build the PI AF asset hierarchy.   
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8.3 Deleting a Rack 

Follow these steps to delete a rack. 

 

8.4 Editing Rack Information 

Follow these steps to change rack information. 

 
 

The Edit Rack Settings dialog will open as shown in Figure 32 and Figure 33. 
 

8.5 Checking the Connection 

The Setpoint – PI Adapter includes a tool to check the security and network settings.   

 

Click the rack to highlight it.  Then click the Delete 
button. 

Click the rack to highlight it.  Then click the Edit 
button. 
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In the above example, the CMS-XC connection was valid, the Service started and was running 
correctly but the client login credentials for the AF server were invalid. 

If the AF database does not exist, the check will verify that the user has permission to create the 
database. 

 

If the connection fails, click the expander to see the 
failure details. 
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8.6 Viewing Connection Status 

The main SETPOINT-PI Adapter screen shows the configured racks and their connection statuses as 
shown in Figure 35.  The rack name that shows is set in the rack configuration.   

 
Figure 35: SETPOINT-PI Adapter 

Table 12 SETPOINT-PI Adapter Status 

 
Status Description 

  Rack Configuration 

The service is starting up or checking for VC-8000 rack 
configuration changes.  If the configuration has changed, the 
service builds the PI AF hierarchy from the VC-8000 rack 
configuration, allocating tags, and loading the hierarchy into the PI 
AF Server. 

   Collecting – Rack Name 

The service is running and collecting data from the listed VC-8000 
rack. 

  No Status shown. The service is stopped and is not collecting data from the listed 
VC-8000 rack.  The Action button will change to the record button. 

The SETPOINT-PI Adapter shows the rack names 
and the connection status to PI-AF and CMS-XC (if 
configured) 

The Status indicates the connection state 
according to Table 12. 
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Figure 36: Connection Information 

8.7 Starting and Stopping Data Collection 

 
Figure 37: Starting and Stopping Data Collection 

Table 13: Adapter Actions 

 
Status Description 

 The rack is not collecting data.  Click the record button to start data 
collection. 

    The service is running and collecting data from the listed VC-8000 
rack.  Click the button to stop data collection. 

Hover the cursor over the status to see more 
information. 

Click the recording button to toggle between stopped and recording.  
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9 CMS Display Software Features 

This section provides an overview of the CMS Display software layout and functions. 

 

Quick Access Buttons 

At the screen top there are buttons for commonly used functions.  

 

You can hide or show buttons using the drop arrow on the right: 

Quick Access Buttons Tabs Ribbon 

Plot Area 

Playback Control Time Readout and 
Cursor Control 

Auto Scale 
  

Save As 
  

Show Zoom Filter 

Compensate 
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Tabs 

The CMS Display software has four main tabs: 

 

 

• File Tab 

• Home Tab 

• View Tab 

• Plot Tab 

Each tab provides the features commonly used at each step of the data analysis process.  Use the 
links above to find information on each tab function. 

Ribbon 

Each tab has a ribbon with commonly used functions.  The ribbon functions are listed in the sections 
for each tab.  You can hide or show the ribbon to increase the plot area. 

The default is to show the ribbons.  To hide the ribbon, click the icon at the right side of the display. 
 
 

 

Click the down arrow to 
show or hide quick access 
buttons. 
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When the ribbon is hidden, the icon changes to a down arrow.  Click the arrow to show the ribbon. 

 

You can also show or hide the ribbons by double-clicking on the tab name 

Plot Area 

Plots for analysing the data are placed in the plot area.  After configuring your data you can increase 
the plot area for analysis. 

Panes 

Panes provide access to detailed information and are opened and closed as you perform certain 
operations.  You can show or hide panes to increase the plot area and dock and undock panes to 
move them to a more convenient location.   

 

• Navigation Pane 

• Events Pane 

• Pages Pane 

• Reference Data Pane 

• Scales Pane 

• Plot Settings Pane 

 

Time Readout and Cursor Control 

The time readout information and cursor controls are shown at the bottom of the screen.  Using these 
controls you can move to the current time, turn on and synchronize cursors, or turn off all cursors. 

 

Playback Control 

Use the playback controls to replay recorded data or to view live data.  
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9.1 The File Tab 

Navigate to the data you need to analyze using the File Tab.  From the File Tab you can 

 

• Connect to a PI Server database 

• Open a saved .cms file 

• Save a .cms file 

• Open a bookmarked dataset 

• Set a default database 

• Export plots and reports 

• Set default units 

• Change the screen colors 

• View the software revision  

 

Go to Home Tab 
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9.1.1 Open a Data Source 

Connect to a database using the Open Database button on the File Tab.  You can connect to PI AF 
databases, CMS-XC computers, or directly to racks with internal storage (CMS-HD). 

9.1.1.1 Connecting to a Recent PI AF Database, CMS-XC Computer or Rack 

If you have connected to the server before, the server will appear in the list of recent items.  Clicking 
on the server name and asset name will connect SETPOINT CMS to that server and asset. 

 

 

 

NOTE! 
If the CMS-XC computer or Rack was configured with a password, you will be prompted to 
enter your password. 
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9.1.1.2 Removing a Database 

To remove a database, click on the database name and then click the Remove Database button. 

 
 

 

NOTE! 
If you delete the currently open database and do not open another database before closing 
CMS, the next time you open CMS, CMS will restore the deleted database. 
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9.1.1.3 Connecting to a New PI AF Database 

If you are connecting to a new server, select Add Database then click the Add Database button. 

 
   

The Select Database window will open: 

  

 

 

1. Click the arrow to get a 
drop list of the available 
PI AF Servers. 

2. Click the Connect button 
to establish the 
connection with the PI AF 
Server.  Note:  If you are 
already connected to that 
server, the Connect 
button will be disabled.   

3. Select your machine 
database from the list of 
databases shown. 

4. Click OK. 
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9.1.1.4 Connecting to a Rack 

If you are connecting directly to a rack with CMS-HD capability, select Add Database and then click 
the Add Setpoint button. 

 
 

Enter the rack IP Address and password as set in the SAM network configuration. 

 

Click OK to establish the connection.  
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9.1.1.5 Connecting to a CMS-XC Computer 

If you are connecting to a new CMS-XC computer, select Add Database then click the Add CMS-XC 
button. 

 

A dialog opens where you enter the CMS-XC computer network name. 

 
 

The software will show a dialog indicating if the connection was successful or failed. 
  

Check the Specify Account 
button if the computer security 
settings require a specific User 
Name and password must be 
specified. 
Click OK to finish the 
connection and return to CMS. 
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9.1.1.6 Setting Default Database 

A CMS user can set a global default database so that any user logging onto the CMS computer will 
default to the global database.  To set the default database, click on the recently opened database 
that you want to set as the default and click the Set Default Database button. 

 
 

A pop-up box opens indicating that the default database has been set to the currently open database.  
Click OK to return to CMS. 
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9.1.1.7 Opening Saved Data from a .cms or cmssd File 

Follow the instructions in this section to open and view data saved from SETPOINT CMS or saved on 
an SD card installed in the VC-8000 rack.  You can use any computer that meets the SETPOINT 
CMS Display computer requirements.  You do not need the OSIsoft AF Client installed when viewing 
saved data. 

  

When opening data stored from an SD card, the file type will be CMSSD.  Data saved from the 
SETPOINT CMS program will be a .cms file type. 

The assets in the imported file will show up in the Navigation Pane.   Since SETPOINT CMS then 
expects to be viewing offline saved files, CMS closes any display connections to an online database.   

When viewing saved data, all controls are active.  Note that the timeline data only shows the data in 
the time range set at the time the data was saved. 

 
 

 

NOTE! 
When using Setpoint CMS version 2017 or later you can double click a .cms file to open CMS 
using that file. 

  

Click Open File to open 
saved .cms  files, .cmssd 
SD card data, or cmsdb 
database files.  The 
software will open an 
explorer window to select 
the file to open.  
 
You can also select a file 
from the Recent Files list. 
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9.1.2 Adding a Bookmark 

You can bookmark a time range and set of plots for quick access in the future.  Use the bookmark 
feature to mark times of specific machine events you want to return to or to create plot arrangements 
that you want to reuse. 

 

 

9.1.3 Using Bookmarks 

 
 
 

From the File Tab, click Bookmarks then 
Add Bookmark to set a bookmark for the 
selected plots and time range.  You will be 
prompted for a bookmark name.  After 
entering a name, CMS will return to the main 
view. 

Click the bookmark name to navigate to the 
bookmark plots selected when the bookmark 
was created.  The timeline is not changed. 

Click the bookmark clock icon to navigate to 
the bookmark time but keeping the currently 
selected points and plots open. 
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NOTE! 
Bookmarks open with the plots pinned.  Clear the pins to remove the plots. 

 

 
 
 
 
  

Click the edit button to change the bookmark 
name.  
Click the button again to exit edit mode. 
  

To delete a bookmark, hover over the name 
until the “X” appears.  Click the “X” to delete 
the bookmark. 
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9.1.4 Saving a Data File 

The SETPOINT CMS data file Save/Open functions allows you to save a range of data in a file.  You 
can then open this file directly into SETPOINT CMS for viewing the data on a computer not connected 
to the PI System database or SD card files. 

Data Save/Open is useful for: 

• Sending data to Machinery Diagnostic Engineers who do not have network access to your 

database. 

• Archiving a specific range of data to document an event. 

• Saving information for review by Brüel & Kjær Vibro Services. 

The Save As function exports all the database data in the set time range for the selected asset.   

After selecting the data points and time range,   

 
  
 

 

IMPORTANT! 
The save data function only exports data for the selected asset and points.  Be sure that all 
points you want data for are selected before saving. 

 
 

From the File Tab, Click Save As. 
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NOTE! 
A large dataset can take a long time to save.  Select only the time range and points you need. 

When the file creation starts, CMS shows a progress dialog.  

9.1.5 Export 

See Section 10.4 Documenting for information on the Export functions.  The Export menu provides 
overviews of the different formats you can export the data as: 
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9.1.6 Setting Default Units 

The default units apply to all plots.  After changing units, all open plots will redraw using the new units 
and subunits.  New plots will open using the current unit settings.  

 
 

Spectrum processing can present the spectrum scaled in peak, peak to peak, or RMS.  Generally, 
you will set the spectrum subunits the same as the direct measurement for comparison between the 
spectrum and trend plots. 

  

From the File Tab click Options to 
set the default units for each 
measurement type. 
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9.1.7 Changing Display and Trace Colors 

Setpoint CMS has two separate color palettes for use with dark or light backgrounds. 

The listed colors apply in order to the channels placed on the plot.   With the palette above, the first 
trace plotted will be goldenrod, the second trace orange, etc.  The following figure shows an example 
of the dark palette: 
 

 

From the File Tab click Options 
to change the background and 
trace color. 
Activating the Lights changes 
the background from dark to 
light. 
 
When the button is light, the 
system will use the “light” 
palette.  When dark, the “dark” 
palette. 
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9.1.8 View the Software Revision 

From the File Tab click About.  The software revision will display: 
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9.2 The Home Tab 

The Home Tab shown below is where you make choices on what data to analyze and what plots to 
present.  

 

 

From the Home Tab, you can: 

• Select points 

• Select plots 

• Select and add reference data  

• Select whether to compensate the data 

• Show or hide overlay data 

 

Go to View Tab 
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9.2.1 Select Points (The Navigation Pane) 

Click the Select Points button on the Home Tab to open the Navigation Pane.  The Navigation Pane 
allows you to quickly select and edit which points will show in the plots and Event Pane. 

 

 

 

NOTE! 
If the Navigation Pane is blank, verify that you have configured an asset path in the 
configuration.   

The Navigation Pane upper section shows the point or asset has the focus.  You can select points 
under, view attributes, or change configuration for the point or asset with the focus. 

In the following example the focus is currently on “Demonet1”.   “Demonet1” has 5 sub assets:  
Turbine Vib, Turbine Axial, Temp, TempA1, and Test.  Checking the box in front of Turbine Vib 
selects all of the Turbine Vib points, shown in the Points view with check marks in front of all of the 
selected points and also lists the selected points in the list at the bottom. 

Demonet1 has several attributes which are rule results set to determine Coastdown, Slow Roll, and 
Stopped conditions.  The machine speed has also been set to show up as an attribute at the 
Demonet1 asset level. 
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Navigate to any asset level by clicking on 
the asset name.   

Assets under “Demonet1” show here.  
Check the box to automatically select all 
points under the asset level. 
 

You can also click the Points bar to show 
all points under the current asset level.  
Check the boxes to select individual 
points. 
 

Selected points show up in the list here.  
When a plot type is activated, plots will 
open for all the selected points. 

Click the Attributes bar to show or hide 
asset attributes.   
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To remove a point from the selected list, 
clear the check box in the Points view or 
hover the cursor over the point in the 
Selected List and click the X on the right. 



 

Page 88 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

9.2.1.1 Viewing Attributes 

The navigation pane also shows attributes assigned to points in PI AF.  Attributes can include 
configuration values, alarm values, or PI AF analysis results. 

You can plot attributes preceded by a check box.  Checking the box adds the attribute to the selected 
list. 

 
 

 

NOTE! 
Unless the attribute is associated with a tag, the attribute will plot as a static, unchanging 
value. 

 
  

Click the Attributes bar to 
show or hide the attributes.  
The Attributes bar will 
highlight when active.  Note 
that not all points have 
attributes. 

Check the box to plot the Alert set 
point attribute on the Trend plot. 
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9.2.1.2 Edit Channel Name 
 

In a CMS file, channel names can be edited to make them clearer when diagnosing machines. 
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9.2.2 Selecting Plots 

Click on a plot icon to open that plot for the selected points.  The highlighted icons indicate active 
plots. 

 

 

Click on a highlighted plot icon to toggle it off.  This will turn the plot type off for all selected points. 

You can change which plot types show on the Home Tab.  For example, if you do not have any 
reciprocating machines you can hide the reciprocating machine plots. 

 

 

 
 
  

Click the arrow in the lower right 
corner of the Plots section. 
A selection list will open. 
Click the plot type to toggle plot 
buttons on or off.  Plot buttons will 
show for plots with a border. 
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9.2.3 Set Reference Data 

Reference data marks a data set at a specific time for use in compensation or for comparison. 

Click the Reference Data button on the Home Tab to open the reference data pane. 

 

The reference data pane opens on the right side of the screen. 

You can use different reference samples for slow roll compensation, waveform compensation, and 
gap compensation or for overlaying. 

Compensation Description Applicable Plots 

Slow Roll 

 

Vector compensation.  The Slow Roll 
compensation vector is subtracted from 
the plotted vectors. 

Filtered Orbit.  
Filtered Timebase.  
Bode 
Polar 

Waveform 

 

Waveform compensation.  The reference 
synchronous waveform is subtracted from 
the data waveform before plotting. 

Unfiltered Orbit 
Unfiltered Timebase. 
Spectrum, Cascade, Waterfall plots when 
plotted in orders of running speed. 

Gap 

 

Sets the gap at the starting position to the 
selected reference gap. 

Shaft Centerline 

Overlay 

 

Sets the sample to overlay on plots along 
with the current data. 

Orbit, Timebase, Spectrum overlay the 
waveform at the reference sample time.   
Bode, Polar, and Shaft Centerline plots 
overlay data from the selected time range 
when the reference sample was created. 

 

The highlighted compensation shown with the symbol above indicates that CMS is using the 
reference sample for that function.  The following picture shows a sample used for all functions: 

 

The next picture shows the References Pane and various changes you can make from the 
References Pane. 
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NOTE! 
You cannot change reference data when viewing live data. 

 

 

NOTE! 
MS-HD and CMS-SD store reference data at the rack level or root level.  When using OSI PI-
AF, CMS-XC or CMS File you can store reference data at the asset level. 

 

Click the tag to open the reference 
data table showing the 
compensation vectors. 

Hover over the reference sample to 
see the options.   Highlighted options 
use the set reference tag. 

Click on the reference data 
timestamp to navigate to that time. 
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9.2.3.1 Adding a Reference Tag 

To add a new reference data set, set the dynamic cursor to the time of the desired reference data 
then click the Add Reference button.  The reference data pane will show the new sample. 

 

 

9.2.3.2 Naming a Reference Sample 

You can change the reference data sample name in the reference data table. 

 

9.2.3.3 Delete a Reference Sample 

Delete reference data from the reference data pane. 

  

Hovering the cursor over the 
reference data sample causes an “X” 
to appear after the sample.  Click the 
“X” at the end of the line to delete a 
reference sample. 

Click on the name and type in a new name 
to change the reference sample name. 
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9.2.3.4 Manually Entering a Compensation Vector 

Manually enter a compensation vector from the reference data table. 

 
 
 
 
 

 
 
 
 
 

  

To manually adjust a reference sample, 
Click on a vector cell and type in a new 
value.  Press enter. 

To stop using a manually entered reference 
value and revert to the original value, click 
the X next to the manually set value. 

Clearing the check box at the beginning of a line changes the 
reference data for that point to the dynamic cursor time.  Use this if 
you want to use data from a different time for some points.  Recheck 
the box to lock the data after setting. 
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9.2.3.5 Locking a Reference Data Archive 

To avoid overwriting reference data, you can mark specific archive files to prevent overwrites.  Use 
the PI System Management Tools, navigate to Operation -> Archives.  Right click the archive you 
want to prevent from overwriting and select “Make Non-shiftable” as shown below. 
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9.2.4 Turning on Compensation 

From the Home Tab, click the Compensate button  to turn on compensation.   

 

 
 

 

NOTE! 
If you have not yet selected a reference tag, the plot will show an error message. 

 
 

9.2.5 Showing and Hiding Overlays 

Refer to Section 10.2.8 for information on using overlays. 

 
  

The Compensation source shows 
highlighted in the header.  If the 
plot cannot be compensated, there 
will be no compensation source 
shown. 
 
The Direct value shows the 
compensated value. 

Click the Overlay Button on the Home Tab to 
turn overlays on or off.   Overlays follow the 
plot settings set on the Plot tab for filtering, 
revolutions, etc. 
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9.3 The View Tab 

The view tab contains configuration for how CMS will show your plots. 

 

From the View Tab you can: 

• Use the Timeline and Zoom Panes used to set the time range. 

• Show or hide data annotations 

• Manually enter a time 

• Zoom the time range in or out 

• Set the selected time range size 

• Show and filter events 

• Open the Pages Pane 

• Change the number of plots shown on a page 

• Clear Pinned Plots 

• Manually scale plots 

• Automatically scale plots 

• Show or Hide the Trend Legend 

 

Go to Plot Tab  
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9.3.1 Show or Hide the Timeline and Zoom Panes 

The Timeline Pane and Zoom Pane buttons control visibility of the Timeline Pane and Zoom Pane.  
Clicking on the button toggles the panes on or off.  When the buttons are highlighted, the panes are 
visible. 

 

CMS uses two key time parameters for plotting data: 

Selected Time Range:  Selects a set of data over time.  The Selected Time Range sets the data 
shown in Bode, Trend, Polar, Shaft Centerline, Waterfall, and Cascade plots. 

Dynamic Cursor:  A specific point in time.  CMS uses the cursor time when selecting the dynamic 
sample to plot for Orbit, Timebase, and Spectrum plots.  Navigating to a time from the Events Pane or 
Reference Data Pane sets the Dynamic Cursor to the event or reference time. 

9.3.1.1 Timeline Pane 

The Timeline Pane provides a way to scroll through the data and select regions for analysis.  The 
Timeline Pane shows trend data for the first several selected points.   You can use the Timeline Pane 
to select the time range of data you want to analysis.   

 

The timeline shows two data points.  To see which points show in the timeline, hover over the timeline 
trace:  

 
 
 

Begin Time Readout      Duration              Dynamic Cursor         Global Cursor On/Off 

Begin Time End Time Selected Time Range 
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To select the active trace to plot, right click on the timeline.  
 

 
 

9.3.1.2 Zoom Pane 

The Zoom Pane is a trend plot that remains visible on any plot page.   Use the Zoom Pane to further 
define your analysis time range. 

 

You can show/hide traces and rubber band zoom the selected time region in the Zoom Pane in the 
same manner as on the Trend plot. 
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9.3.2 Manually Enter a Time Range  

You can quickly navigate to a time range by manually setting the date and time.  CMS will set the 
dynamic cursor time to the set time and center the selected time range on the set time. 

 

 
 

 

 
  

Set the date on the calendar 
and the cursor time.  Then click 
OK to move to the set time. 
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9.3.3 Zoom the Selected Time Range In or Out 

Clicking the Zoom In button reduces the selected time range in half.  The Zoom Out button doubles 
the selected time range.   

 

Zoom functions are anchored at the end time range.  In the example below the selected time range 
ends at 03:35:59 PM and the duration is 1 hour, 0 minutes. 

 

Clicking the Zoom In button reduces the duration to 30 minutes.  The time range end remains the 
same:  

 

Clicking the Zoom Out button from the original 1 hour selected time range increases the selected time 
range to 2 hours.  
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9.3.4 Set the Time Range Size 

The time range size buttons set the selected time range duration in the timeline. 

 

The end time remains constant.  The begin time moves in time to set the duration. 

Button Duration Timeline Length 

1 w 1 week 13 weeks 

1 d 1 day 14 days 

1 h 1 hour 8 hours 
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9.3.5 Show or Hide Data Annotations 
 

 

 
 
 
 

9.3.6 Show or Hide Waveform Tick Marks 

 
 

The height of the tick mark above the axis shows how interesting SETPOINT found the data.  You 
can change the axis scale from the % setting in the Units Pane.  Setting a larger percentage pushes 
the tick marks down toward the axis. 

  

Selecting “Waveform” from the 
Trend controls on the Plot Tab will 
show the waveform tick marks on 
the Trend and Zoom Panes.  
 
The tick marks show when 
SETPOINT stored a waveform 
sample.   

Show Data Annotations displays the 
alarm markers, state markers on the 
Trend Plot and Zoom Pane. 
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9.3.7 Show and Filter Events (The Events Pane) 

Click the Events button on the View Tab to open the Events Pane. 

 

The Events Pane shows alarm, state and system events that occurred in the Timeline Pane whether 
in the selected time range or not.  You can navigate directly to points and time ranges corresponding 
to the events directly from these lists.  CMS defaults to showing the alarm list on the right as shown:    

 

 

 

NOTE! 
The Events list is filtered to show events for the selected points. The list will also include top 
level system events. 

You can filter the event list to only show Danger, Alert, or System events by clicking the buttons 
shown.  All events are shown is no buttons are active.  When an event type is active, the type is 
highlighted: 

 

From the View Tab, clicking the Events 
button opens the Events Pane. 
 
Close the event list by clicking the X in 
the upper right corner of the Events 
Pane. 



 

© Brüel & Kjaer Vibro ● S1176125.002 / V03 ● █ Page 105 of 234 
Technical alterations reserved! 

© Brüel & Kjaer Vibro │Instruction Setpoint Condition 
Monitoring Software  CMS Display Software Features  EN 
   

9.3.8 Opening the Pages Pane 

Open the Pages Pane for selecting the plots shown by clicking the Select Page button on the View 
Tab. 

 

 

 
 

9.3.9 Change the Number of Plots Shown on a Page 

Click the buttons to select one, two, or four plots per page. 
 

 
  

The Pages Pane groups the plots by the selected 
number of plots per page.  The current page is 
highlighted. 
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9.3.10 Clear Pins 

The clear pins button un-pins any plots currently pinned.  If the pinned plot types have been 
deselected, the plots will disappear. 

 
 

9.3.11 Change Scales (Manual Scale) 

From the View Tab, click the Change Scales button to open the Scales Pane.  Use the Scales Pane 
to manually scale plots to the set value. 

 

 

 

 

 

Set the full scale range for each 
unit.  When Auto Scale is 
turned off, plots using the given 
unit will scale to the set value.   
 
Minimum values are used only 
on the Trend and Reciprocating 
Compressor plots. 
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9.3.12 Auto Scaling 

You can scale plots automatically according to the data using the Auto Scale button on the View Tab.  
Auto Scale selects the best full scale to optimize the data presentation for the plots. It can either 
scale each plot independently (Auto Each) or all plots of the same type together (Auto All).   

When scaling in Auto All mode the scale will automatically adjust to the size of the largest values 
viewed in the plot.  As data grows smaller the scale will stay at the largest values seen.  

 

To reset the scale in Auto All mode use the Reset Auto Scale button on the View Tab.  
 

Toggle the Auto Scale button off to return the plots to the configured scale.    
 

9.3.13 Show or Hide the Plot Header Information 

The Plot header controls allow you to show or hide plot header information.  Plot header information 
is useful for annotating plots in reports, but you may want to hide the information to maximize the plot 
area when analysing the data.   
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Checking Asset Path checkbox shows the full asset path in the header. 
  

Show Title shows the set Title. 

Checking Horizontal displays the 
channels in a horizontal format.  When 
not checked the information is displayed 
to the right of the plot. 

Checking Time Range displays the plot 
time range. 

Checking Notes checkbox displays the 
set note in the plot settings.  Notes are 
set individually for each plot. 
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9.4 The Plot Tab 

The Plot Tab includes commonly used controls for analyzing plots. 

 

The Plot Tab is broken into sections for:  

• Orbit/Timebase plot control,  

• Trend plot control,  

• Bode/Polar plot control,  

• Spectrum plot control, and  

• Reciprocating Compressor plot controls.   

Cascade and Waterfall plots are controlled using the Spectrum settings. 
  



 

Page 110 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

9.4.1 Orbit/Timebase Controls 

The Orbit/Timebase Controls apply to the Orbit, Timebase, and Orbit/Timebase plots. 

 
 
9.4.1.1 Turn on Filtering 

Filtering applies to the Orbit, Timebase, and Orbit/Timebase plots.   

You can filter the plots to show only the 1X, 2X, or nX vector components.   
 
 
 
 
 
 
 
 
 
 

 NOTE! 
To show filtered data, the UMM must be configured to measure the 1X, 2X, or nX vector. 

 

 

NOTE! 
If the vectors are integrated, the filtered waveform will also be integrated. 

 

After you have set the filter harmonic, you can use the quick access filter button to toggle filtering on 
and off. 

 

9.4.1.2 Adjusting the Number of Revolutions 

You can change the number of shaft revolutions shown on the Orbit or Timebase plots from the 
default value of 8 revolutions.  For example, changing Orbit Revolutions to 16 results in the Orbit with 
16 revolutions plotted. 

To filter an Orbit or Timebase to a 
specific component: 

1. Open the Plot Tab. 

2. Click the Filter button. 

3. Select the vector 
harmonic to filter to. 
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The maximum number of revolutions shown is limited by the dataset.  Boost mode data supports 
much higher numbers of revolutions.  The following figure shows two Orbit/Timebase plots.  The plot 
on the right was collected in boost mode and shows the full 60 revolutions.  The plot on the left was 
collected in standard mode and is limited to the 16 revolutions shown. 

 

The following table shows the number of revolutions collected when not in boost mode for the 
configured sample rate.  1024X and 512X sample rates are only available for reciprocating 
compressor channel types. 

 
Sample Rate  Revolutions 

1024X 2 

512X 4 

128X 16 

64X 32 

32X 64 

16X 128 
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9.4.1.3 View the Asynchronous Timebase 

By default, the timebase plot will show the synchronously sampled waveform.  You can also plot the 
asynchronously sampled waveform.  To view the asynchronous timebase: 

1. Select the timebase plot on the Home tab.  Turn Orbit off. 

2. On the Plot Tab, click the Asynchronous Timebase checkbox: 

 

The asynchronous waveform will not have phase trigger marks and cannot be filtered or 
compensated. The synchronous waveform always shows the number of configured shaft revolutions.  
The asynchronous waveform will show fewer revolutions at low speed and more at higher speeds as 
shown by the following figures:   

 

 

At low speed.  The header indicates the 
waveform type 
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Data collected in boost mode supports long, continuous waveforms.  You can configure the 
Asynchronous Timebase to set the amount of asynchronous timebase data plotted. 

 

Boost mode data can show continuous waveforms much longer than a typical 2048 point waveform.  

 

 
  

At high speed.  Asynchronous waveform on 
the left, synchronous on the right: 
  



 

Page 114 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

9.4.2 Trend Controls 

You can filter the data shown to only include set types of measurements.  For example, if you want to 
only see 1X vector measurements on your Trend, check the 1X box and clear all the others. 

 

To change the measurements shown in the ribbon, click the expand arrow:  

 

The dialog shown below opens.  Click the measurements you want visible or hidden.  After selection, 
the visible measurements will be boxed as shown below. 

 

When finished, click the X to close the window. 

The following tables show the association of the measurements to the Trend Controls. 
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Channel 

Type 
Measurements Trend Group 

Acceleration Direct (primary) Direct 
Bias Gap 

1X Amplitude 
and Phase 

1X Amplitude, 1X 
Phase 

2X Amplitude 
and Phase 

2X Amplitude, 2X 
Phase 

Bandpass Accel Bandpass 
nX nX Amplitude, nX 

Phase 

Accel Slow 
RMS 

Direct (primary) Direct 
Bias Gap 

Acoustic Direct (primary) Direct 
Bias Gap 

Band-pass  
filters 1 to 8 

Bandpass 

Aero Accel Aero 1X 
Tracking Filter 

(primary) 

Direct 

Band-pass 1 Bandpass 
Band-pass 2 Bandpass 

Bias Gap 

Aero 
Velocity 
Tracking 

1X Tracking 
Filter 

Direct 

Band-pass Bandpass 
Bias Gap 

Aero 
Velocity 

Bandpass 

Primary Band-
pass 

Direct 

Added Band-
pass 

Bandpass 

Bias Gap 

Axial 
Position, 

Axial 
Position w/ 

sync 

Axial Position Position 
Gap Gap 

Axial Vibration Bandpass 

Case 
Expansion 

Direct 
 

Position 

Case 
Expansion 

(2 ch) 

Differential 
Case Expansion 

Position 

Direct 1 Position 
Direct 2 Position 

 
 
 
 

Channel 
Type 

Measurements Trend Group 

Diagnostic 
Acceleration 

Direct (primary) Direct 
Bias Gap 

1X Amplitude 
and Phase 

1X Amplitude, 1X 
Phase 

2X Amplitude 
and Phase 

2X Amplitude, 2X 
Phase 

nX Amplitude 
and phase 

nX Amplitude, nX 
Phase 

Diagnostic 
Proximity 

Direct Direct 
Gap Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

nX amplitude 
and phase 

nX Amplitude, nX 
Phase 

Diagnostic 
Velocity 

Direct Direct 
Bias Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

nX amplitude 
and phase 

nX Amplitude, nX 
Phase 

Diff Exp 
Single 
Probe 

Direct Position 
Gap Gap 

Diff Exp 
Comp Input 

Composite Position 
Direct 1 Position 
Direct 2 Position 
Gap 1 Gap 
Gap 2 Gap 

Diff Exp 
Dual Ramp 

Composite Position 
Direct 1 Position 
Direct 2 Position 
Gap 1 Gap 
Gap 2 Gap 

Diff Exp 
Single 
Ramp 

Composite Position 
Direct 1 Position 
Direct 2 Position 
Gap 1 Gap 
Gap 2 Gap 
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Channel 

Type 
Measurements Trend Group 

Discrete 
Input 

Digital State Direct 

Dynamic 
Pressure 

Direct Direct 
Bias Gap 

Pressure Band-
pass 1 

Bandpass 

Pressure Band-
pass 2 

Bandpass 

Pressure Band-
pass 3 

Bandpass 

Eccentricity PP Eccentricity Direct 
Gap Gap 
Min Position 
Max Position 

Ecc Position Position 

Enveloped 
Acceleration 

Direct Direct 
Bias Gap 
Cage Bandpass 
IRBP Bandpass 
ORBP Bandpass 

Ball Spin Bandpass 
2X Ball Spin Bandpass 

Hydro 
Radial 

Vibration 

Direct Direct 
Gap Gap 

1X Amplitude 1X Amplitude 
2X Amplitude 2X Amplitude 
Bandpass 1 Bandpass 
Bandpass 2 Bandpass 
Bandpass 3 Bandpass 
Bandpass 4 Bandpass 
Bandpass 5 Bandpass 
Bandpass 6 Bandpass 
Bandpass 7 Bandpass 
Bandpass 8 Bandpass 

 
 
 
 
 
 
 
 
 

Channel 
Type 

Measurements Trend Group 

Hydro 
Velocity 

Direct Direct 
Bias Gap 

1X Amplitude 1X Amplitude 
2X Amplitude 2X Amplitude 
Bandpass 1 Bandpass 
Bandpass 2 Bandpass 
Bandpass 3 Bandpass 
Bandpass 4 Bandpass 
Bandpass 5 Bandpass 
Bandpass 6 Bandpass 
Bandpass 7 Bandpass 
Bandpass 8 Bandpass 

Low 
Frequency 

Acceleration 

Direct Direct 
Bandpass Bandpass 

Bias Gap 

Low 
Frequency 

Velocity 

Direct Direct 
Bias Gap 

Phase 
Trigger 

Speed Speed 
Gap Gap 

Rotor 
Acceleration 

Speed 

Peak Speed Speed 

Process 
Variable 

Direct Direct 
Bias Gap 

Radial 
Vibration 

Direct Direct 
Gap Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

nX  nX Amplitude, nX 
Phase 

Band-pass 1 Bandpass 
Band-pass 2 Bandpass 
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Channel 
Type 

Measurements Trend Group 

Radial 
Vibration Air 

Machine 

Direct Direct 
Gap Gap 

1X Amplitude 1X Amplitude 
2X Amplitude 2X Amplitude 
3X Amplitude nX Amplitude 
4X Amplitude nX Amplitude 

Bearing, 
Resonance, 
Resonance 

(2nd) 

Bandpass 

Radial 
Vibration 

with Smax 

Smax Direct 
Direct Direct 
Gap Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

REBAM 
Channel 

Direct Direct 
Gap Gap 

Rotor Region Bandpass 
Prime Spike Bandpass 

REB 
Acceleration 

& REB 
Acceleration 

(Slow) 

Overall Direct 
Prime Spike Bandpass 

HF 
Demodulated 

Bandpass 

Bias Gap 

Recip 
Crankcase 

Velocity 
 
 

Direct Direct 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

Bias Gap 

Recip 
Impact 

Impact Count Direct 
Maximum Direct 

Bias Gap 

 
 
 
 
 
 
 
 

Channel 
Type 

Measurements Trend Group 

Recip 
Cylinder 
Pressure 

Compression 
Ratio 

Pressure 

Discharge 
Pressure 

Pressure 

Maximum 
Pressure 

Pressure 

Minimum 
Pressure 

Pressure 

Peak Rod 
Compression 

Pressure 

Peak Rod 
Tension 

Pressure 

Rod Reversal 
Degrees 

Pressure 

Suction 
Pressure 

Pressure 

Recip Rod 
Drop 

Rod Runout Direct 
Average Piston 

Position 
Position 

Average Gap Gap 
Triggered 

Piston Position 
Position 

Triggered Gap Gap 

Recip Rod 
Position 

Direct PP Direct 
Gap Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

Crank Angle Position 
Rod Pos 

Magnitude 
Position 

Rod Pos Phase Position 

Reverse 
Rotation 

Rev Speed Speed 
Num Rev 
Rotations 

Speed 

Rev Peak 
Speed 

Speed 

Forward Speed  Speed 
Gap 1 Gap 
Gap 2 Gap 

Shaft 
Absolute RV 

Shaft Abs Direct Direct 
Direct Direct 
Gap Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 
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Channel 
Type 

Measurements Trend Group 

Shaft 
Absolute Vel 

Velocity Direct Direct 
Intg Direct Bandpass 

Bias Gap 
1X amplitude 

and phase 
1X Amplitude, 1X 

Phase 
2X amplitude 

and phase 
2X Amplitude, 2X 

Phase 

Simulated 
Phase 
Trigger 

Speed Speed 

Tachometer Speed Speed 

 Gap A Gap 

Tracking 
REB 

Acceleration 

Overall Direct 
1X amplitude 

and phase 
1X Amplitude, 1X 

Phase 
Bias Gap 

Ball Spin Bandpass 
2X Ball Spin Bandpass 

Cage Bandpass 
HF 

Demodulated 
Bandpass 

IRBP Bandpass 
ORBP Bandpass 

 

 
 
 
 
 
 
 
 
 

Channel 
Type 

Measurements Trend Group 

Valve 
Position  

Direct Direct 
Bias Gap 

Velocity Direct Direct 
Bias Gap 

1X amplitude 
and phase 

1X Amplitude, 1X 
Phase 

2X amplitude 
and phase 

2X Amplitude, 2X 
Phase 

Band-pass Bandpass 
nX amplitude 

and phase 
nX Amplitude, nX 

Phase 

Zero Speed Zero Speed Speed 
Speed Speed 
Gap Gap 

Peak Speed Speed 
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9.4.3 Spectrum Controls 

The spectrum controls apply to the Spectrum, Waterfall, and Cascade plots. 

 

9.4.3.1 Viewing the Full Spectrum 

SETPOINT CMS generates the full spectrum from an XY probe pair.  The resulting full spectrum is 
the spectrum of the orbit with forward and reverse vectors that define the orbit.   

 

 

Full spectrum plot cursors show both the forward and reverse precessing values for the selected 
frequency or order. 

 

Header shows Full Spectrum 
indicator when a full spectrum is 
plotted. 
  

Forward precessing components  Reverse precessing components  

X Axis origin 
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9.4.3.2 Show Order of Running Speed:  

Select this option to generate the spectrum data from the synchronous sampled data and display in 
orders of running speed. 

 

Set the X maximum scale on the Scales Pane.  The X scale does not autoscale. 

9.4.3.3 Integrating Spectrums 

Click the Integration button to integrate spectrums, cascade spectrums, or waterfall spectrums from 
acceleration units to velocity units or from velocity units to displacement units as set in the default 
units.  On the integrated spectrum, the spectral components below 10 Hz may have errors caused by 
high integration gain at low frequencies. 

 

Click the Integration button again to return to non-integrated units. 

 

 

NOTE! 
Integration is only available on spectrum plots.  Orbits and Timebase plots are not integrated. 

9.4.3.4 Number of Spectral Lines:   

Allows you to adjust the spectrum resolution.  If the number of spectral lines exceeds the maximum 
for the sampling configuration, CMS will interpolate the data to provide a smoother plot. 
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NOTE! 
Interpolation does not improve resolution beyond what is supported by the sample rate.  
When combined with windowing, the interpolation only provides a smoother data 
presentation.  Without windowing, the interpolation can increase side lobes. 

9.4.3.5 Displayed Waveforms:  

Spectral Display Limit applies only to Cascade and Waterfall plots.  This is the maximum number of 
spectrums that CMS will display on these plots.  A large spectral display limit provides more detail but 
takes longer to plot.  

 

9.4.3.6 Spectrum Window Type 

Windowing can enhance the spectrum display for amplitude and frequency accuracy.  The Window 
type applies to all open spectrum plots.  Window choices are:  No Window, Blackman, Hamming, and 
Hanning.  The following figures show the effects of the various window types. 

 

 

 

 

No window applied. 
Notice the skirting around the peak 
components.  The skirting is not real 
machine data – it is caused by the spectrum 
Fast Fourier Transform processing. 
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 Hanning: 

 

Blackman: 

 

Hamming:  

 

 

Hanning window applied. 
Notice the skirting around the peak 
components is reduced.  The energy moves 
to the fundamental which increased from 
0.34 to 0.4 by applying the Hanning window. 

Blackman window applied 
Similar to Hanning, the Blackman window 
reduces skirting and brings the peak closer 
to the actual value. 
Some consider Blackman to be a superior 
window to Hanning. 

Hamming window applied 
Similar to Hanning, the Hamming window 
reduces skirting and brings the peak closer 
to the actual value. 
In general, the Hanning and Blackman 
windows are superior to the Hamming 
window.  The Hamming window is provided 
for comparison with other tools using the 
Hamming window.   
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9.4.3.7 3D Cursor 

The 3D Cursor control applies only to Cascade and Waterfall plots.  Standard mode causes the 
cursors to track the X-Axis point when using the Up/Down arrow keys to move between spectrums.  
Track Orders causes the cursor to follow the current order.  For example, if you click on the 1X 
harmonic component in Track Orders mode and then use the arrow keys to move to the next 
spectrum, the cursor will move to the 1X harmonic regardless of the speed. 

 

9.4.3.8 Default 3D View 

You can rotate the Cascade and Waterfall plots to different viewing angles to better see the harmonic 
content.  The default 3D view sets the way a new cascade or waterfall plot will open. 

 

 

9.4.3.9 3D Plot Walls 

You can display or hide the Y axis scales and back wall on the Cascade and Waterfall plots. 

 

 

The views are listed as compass coordinates. 
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9.4.3.10 Enable Bearing Cursors 

If bearing frequencies are assigned to the point (reference REB Solutions Manual S000002001) 
checking Bearings will display the bearing frequency cursors on the spectrum plot. 

 

The bearing frequency cursors are shown on the plot and the cursor names and amplitudes are 
shown on the right. 

 
  

3D Plot Walls active shows the wall on the 
back of the plot and the Y axis scale at the 
front. 
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9.4.4 Bode and Polar Plot Controls 

Choose which vector data values to plot on the Bode and Polar plots. 

 

 

NOTE! 
If Bode or Polar plots are activated with no vector selected, the Bode plot will open showing 
the 1X vector. 

 

You can also plot the Direct value on the Bode.  All selected Direct and vectors plot on the same 
Bode plot to allow you to quickly determine which vector is influencing the Direct value.  Different 
vectors open separate Polar plots. 

The Time checkbox labels the Polar and Shaft Centerline plot points with the sample time.  When the 
Time checkbox is cleared the points are labelled with the speed. 

 
  

    Points labelled with speed                                                  Points labelled with time 
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9.4.5 Reciprocating Compressor Controls 

Reciprocating compressor controls apply to the Pressure-Volume Diagrams, Rod Load Diagrams, 
and Rod Position plots used to analyze Reciprocating Compressors. 

 

See Pressure-Volume Diagram for information on the adiabatic curve. 
 

9.4.5.1 Changing the Recip Number of Revolutions 

Change the number of revolutions to see a data samples plotted over more or fewer revolutions on 
the Rod Position plot. 
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9.5 Tell Me What You Want to Do 

The “Tell me what you want to do” input line is a combination help, search, and control line.   

Entering a key word such as “Bode” will show options for opening the Bode plot or viewing the Bode 
plot help information. 

Entering a point name will open the navigation pane at that point level. 

 

For example, typing in the word Orbit lists several options: 

 

 

 

 
  

Change the number of 
revolutions that show on the 
Orbit or Timebase plot. 
Open the Orbit Help. 
Open the Orbit/Timebase Help. 
Open the Orbit plot. 
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10 Using the CMS Display Software  

This section lists the basic flow for using the CMS Display Software and discusses typical ways to 
perform tasks. 

The basic flow consists of: 

• Setting Default Units 

• Opening a data source 

• Selecting the assets and points you want to analyze 

• Configuring the plots 

• Selecting the data time range 

• Analyzing the data  

• Create a report 
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10.1 Setting the Time Range 

Setting the time range sets the data for plotting Trend, Bode, Polar, Waterfall, and Cascade plots. 

By default, plots open with the time range set to the time range from the last session. 

Set the time range to: 

• Move to the Current Time 

• View Data From a Specific Time Range 

• View Data Around an Event 

• Zoom in on Selected Data 

10.1.1 Move to the Current Time 

Click the clock icon to move the selected time range to end at the current time.   

 

10.1.2 View Data from a Specific Time Range 

When you know the time of a machine event you want to analyze, such as a machine startup at 12 
pm on December 1, 2015,   use Go To on the View Tab to navigate directly to that time. 

 

10.1.3 View Data around an Event 

When you are looking for an event, such as an alarm or machine startup, you can automatically set 
the point and time range from the Events Pane.   
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10.1.4 Zoom in on Selected Data 

Once the selected time range includes the data you want to analyze, there are several ways to zoom 
in or out to see more detail or data before or after the event. 

 

 
  

Clicking on the point name in the event will 
change to that point in the Navigation Pane.   

Clicking on the event time centers 
the selected time range on the 
event time.   

The machine coast-down data you want is in 
the selected region.  Now you want to zoom 
in. 
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10.1.4.1 Zoom in the Zoom Pane 

Open the Zoom Pane from the View Tab.   Drag the mouse across the Zoom Pane to rubber-band 
zoom on a section of data. 

 

You can also use the Zoom In and Zoom Out buttons to reduce the time range. 
  

Zoom in further on a specific time range by 
rubber band zooming in the Zoom Pane. 
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10.1.4.2 Zoom on the Trend Plot 

 

You can also use the Zoom In and Zoom Out buttons to reduce the time range. 

10.1.4.3 Move the Timeline Handles 

 

 

 

 
  

Zoom in on a specific time range by rubber 
band zooming on the Trend plot. 
This will change the time range begin and 
end times to the selected region. 

Click either the begin time or end time and 
drag to adjust the selected time. 
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10.1.5 Data of Interest is Shown in the Timeline, but not Selected  

 

 

 

The machine startup data you want is visible 
in the timeline, but is not in the selected 
region.  You want to change the selected 
time range to include the startup. 
  

Click on the selected  time range slider control and drag the 
selected time window to the left.  This changes the begin time but 
keeps the duration the same. 
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Alternatively, you can increase the selected time range by zooming out, moving the timeline handles 
or changing the time range size buttons. 

10.1.6 Data is Not Shown in the Timeline 

In the example below, the timeline is not showing the shutdown that occurred several days before the 
current period of non-operation: 

 

The machine startup is now in the selected 
time range and appears in the plots. 
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Increasing the time range size will show more days in the timeline: 

 

Slide the range all the way to the left end to see the previous time period or to the right to see more 
current data. 
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10.2 Analyzing the Data 

This section describes various tasks you can perform while analyzing your data.  These include: 

• Paging through plots 

• Changing the number of plots shown on a page 

• Zooming in on a plot 

• Expand a plot to full screen 

• Automatically scale the data 

• Manually scale the data 

• Compensate the data 

• Maximizing the plot area 

• Using cursors 

• Viewing live data 

• Playing back recorded data 
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10.2.1 Paging Plots 

This section describes the ways to page through the plots.  Open the Pages Pane from the View Tab.  
You can also page plots or open the view tab using the controls at the lower left of the screen as 
shown below. 

 

 

10.2.1.1 Paging through Plot Types for a Group of Channels 

Follow these instructions when you want to view the same plot type on several channels.    

 

  

Click on the right or left arrows at the bottom of the screen to page 
to the next or previous plot. The arrows are not active if there is 
only one plot page.  You can also use the Alt key and the left and 
right arrow keys to page plots. 

Click on “Page” to open up the Pages Pane.  The Pages Pane 
shown below gives a preview of the plots on each page and allows 
quick navigation between pages. 
  

Select the points or bearings that you want to 
view using the Navigation Pane. 
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1) Select the plot types you want to compare. 
2) Set the number of plots shown on a page to 2 or 4. 
3) Use the Pages Pane to page through the plots. 

10.2.1.2 Paging through different plots for a channel or bearing 

To page through the various plot types for a single channel or bearing follow the links for these steps: 
1) Select the channel or bearing using the Navigation Pane. 
2) Turn on the desired plots. 
3) Use the Pages Pane or the page arrows to page through the plots. 

 

10.2.1.3 Get Two Plots Next to Each Other for Comparison 

There are several ways to get two plots next to each other for comparison. 

If the plot types are different but are on the same channel, you can remove unwanted channels from 
the selected data.  

Example:  Put Orbit/Timebase and full spectrum side by side for a bearing: 
1) Use the Navigation Pane to select the bearing and remove other points from the selected 

data list. 
2) Select two plots per page. 
3) Turn on Orbit, Timebase, and Spectrum plots and turn the other plots off. 
4) Set the spectrum for Full Spectrum. 

If the plots are the same type but on different channels: 
1) Use the Navigation Pane to select the desired channels and remove other points from the 

selected data list. 
2) Select two plots per page. 
3) Turn on the plot type you want and turn the others off. 

If the plots are of different types and on different channels: 
1) Pin the plots that you want to compare. 
2) Select two plots per page. 
3) Turn off all plot types so only the pinned plots display. 
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10.2.2 Zooming in on a Plot 

You can rubber-band zoom on the Timebase, Shaft Centerline, and Spectrum plots as shown: 

 

You can also use the mouse scroll wheel to zoom in or out on the Timebase plot. 

 

  

Drag the cursor 
across the plot to 
select an area to 
zoom in on. 
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10.2.3 Increasing the Plot Area 

You can increase the area available for viewing plots by: 

Collapsing the ribbon 

Closing the Timeline 

Undocking panes and moving them out of the plot area 

The following figure shows the plot area maximized. 

 
 

10.2.4 Full Screen a Plot 

You can quickly expand a plot to fill the full screen by clicking the full screen icon.  Hover the cursor 
over the plot to show the plot controls in the plot upper right corner.  Select the full screen button as 
shown: 

 

Press the Escape (ESC) key to exit full screen mode.  
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10.2.5 Rotating and Sizing Waterfall and Cascade Plots 

You can rotate and size the Waterfall and Cascade 3-dimensional plots differently than the default 
view. 

 

10.2.5.1 Sizing a Waterfall or Cascade Plot 

 

To  rotate a plot, click outside the plot 
area and move the mouse.   

To restore a plot to the default rotation 
view, click the rotation icon in the 
header.   

To change the size of the 
plot, click + or – buttons 
or click inside the plot 
area and use the mouse 
scroll wheel. 
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10.2.6 Docking and Undocking Panes 

Any panes opened can be freely moved around the plot area. 

To undock a pane, hover over the title until the cursor turns into the pan icon:   

 

Click and drag the pane across the screen.  The plot area will resize and the pane can be freely 
moved around the screen.  The pane does not need to be located in the plot area. 

 

To dock the pane on the right or left, drag the pane so it overlaps the right or left side of the plot area.  
The dock area will highlight.  Release the mouse button to doc the plot. 
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10.2.7 Using Cursors 

Cursors provide you with a numerical readout of the value at a specific point on the plot. 

Click on plot to activate a single cursors.  Use the right/left arrow keys to move the cursors to the right 
or left.  Hold down the arrow key to move the cursor faster.  You can create separate cursors on 
separate plots each showing the cursor time and the data values at that time.   

 

  
  

Click on the plot to create a cursor.  The 
values at the cursor are shown in the 
legend. 
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You can synchronize the cursor time with other plots: 

 

Overall cursor controls are shown at the bottom of the screen.  To enable cursors on all plots, click 
the cursor button to highlight it as shown below.  To hide all cursors, click the cursor button again to 
clear. 

 

Clicking the Set Cursors button next to the timestamp will set all cursors to the time shown. 

 

Click on the cursor dot or click the cursor 
time to synchronize all plots to this time. 
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10.2.7.1 Difference, Harmonic and Sideband Cursors 

The spectrum plot supports single, difference, harmonic, and sideband cursors.  The Trend and 
Timebase plots support single and difference cursors.  Follow these instructions to activate these 
cursors: 

 

If overlays are active, there will be a data column for the overlay. 
  

Right click on the spectrum plot to 
activate difference, harmonic or sideband 
cursors. 
  

Hover over a cursor until the pointer 
turns to a double ended arrow.  Click and 
drag the cursor. 
Cursor values are shown to the right. 
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10.2.8 Using Overlays  

You can overlay a selected data set on the plot along with the currently selected data.  The overlay 
function uses reference data samples.  To overlay data: 

1. Set a reference data sample for the data you wish to overlay.  (See section 9.2.3) 

2. Select the reference data sample you want to overlay.  From the Home Tab, click the 
Reference Data button to show the Reference Data Pane. 

3. Select the reference sample to overlay. 

 

Click the Overlay Button on the Home Tab to turn overlays on or off.   Overlays follow the plot settings 
set on the Plot tab for filtering, revolutions, etc. 

When the overlay button is active, the waveform from the selected reference time will be plotted along 
with the current waveform: 

Hover over the reference sample you 
want to overlay and click Overlay. 
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You can activate overlays simultaneously to viewing live data.  This is very useful with Bode, Polar, 
and Shaft Centerline plots for comparing the current live values with a reference: 

 

 

Header shows data for both current 
and reference waveforms. 
 
Hover over a trace to identify current 
and overlay waveforms. 
 
Current waveform. 
 
Reference waveform. 
 

Cursor shows values for both current 
and overlay waveform. 
  

Current live data. 
  
Reference waveform. 
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10.2.9 Viewing Live Data 

Clicking the Running Man button causes all of the plots to update automatically as new data is 
loaded into the PI database. 

 

Click the square Stop button to stop live mode.   

 

 

NOTE! 
When viewing live data, the plots are updated every 2 seconds.  If the data is changing 
rapidly, when you exit live mode, you will see additional information filled in from the historical 
database. 

 

 

NOTE! 
In live mode, the Cascade and Waterfall plots will stop updating when they reach the 
displayed waveform limit.  Increase the number of displayed waveforms or decrease the 
selected time to resume updates. 
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10.2.10 Playback Function 

In playback mode, the software takes the selected time range and plays the data back from dynamic 
cursor time to end time. 

 

You can speed up the playback by repetitively clicking the playback button.  The playback button 
changes to indicate the playback rate: 

Icon Description 

 
Data plays back in real time. 

 Playback is sped up by a factor of 4. 

 Playback is sped up by a factor of 16. 

 

Playback starts from the dynamic cursor location.  Click the square Stop button to stop playback 
mode. 
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10.2.11 Changing Plot Settings 

CMS requires various pieces of point information to correctly plot and annotate data plots.  For 
example, the shaft absolute plot requires bearing clearances in order to place them on the plot.  CMS 
stores this information in PI AF.  The ellipsis icon is grayed out if there are no configurable settings for 
the plot. 

 

The Plot Settings Pane will open: 

 

 

 

To edit plot settings, hover over the plot 
until the icons appear in the upper right 
plot corner and click the ellipsis icon. 
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You can set these values from the Plot Setting Pane: 

Setting Description Applicable Plot 
Type 

Horizontal Bearing 
Clearance 

The bearing clearance in the horizontal direction. Shaft Centerline 

Vertical Bearing 
Clearance 

The bearing clearance in the vertical direction. Shaft Centerline 

Shaft Reference 
Location 

The location in the bearing where the shaft is when the machine 
is at rest:  Top, Bottom, or Center. Shaft Centerline 

Machine Orientation Provides a reference designation to where 0 degrees is.  For a 
horizontal machine this will typically be “Up”.  However, for a 
vertical machine the orientation may be another designation 
such as “North”. 

Shaft Centerline, 
Orbit 

Alert Level Plots a circular region corresponding to the entered alert level. Rod Position 

Danger Level Plots a circular region corresponding to the entered danger 
level. Rod Position 

Notes Free text field for plotting a note on the plots.  The notes are 
unique for each plot. All 

 

10.2.12 Viewing Alarms Markers 

You can view measurement alarm status using markers on the Trend plot or using the data table. 

 

 

 

 

Markers in the data table cells indicate 
the alarm status. 
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Turn on Data Annotations to show markers on the Trend plot that show a change in the measurement 
alarm status.  This is a powerful tool that graphically shows which channels entered alarm first (First 
Out) and the following alarm sequencing.   

  

 

 

NOTE! 
The markers are only shown if there are alarms configured for the measurements used by the 
plot and Show Data Annotations is on.  For example, the Trend plot showing only 1X 
amplitude and phase and will only show alarm markers if there are 1X amplitude or phase 
alarms configured. 

 

 

NOTE! 
If multiple alarms occur at the same time (for example, a rapidly increasing vibration exceeds 
the alert and danger setpoints simultaneously) only the highest status is shown. 

 

 

NOTE! 
Alarm markers include the configured alarm time delay.  If a machine transitions rapidly from 
no alarm through both alert and danger levels, danger may be indicated before alert if alert 
has a longer configured time delay. 

You can turn on and off the alarm markers using the Show Data Annotations button on the View Tab. 

Yellow: Entered Alert State.  
Yellow: Re-entered Alert State 
(Exited Danger State) 
 
Green: Entered Normal State 
(Exited Alert State) 

Red: Entered Danger State 
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10.2.13 Plot Alarm Levels on Trend  

You can plot alarm limits on the trend plots.  To add an alarm level to a plot, open the Navigation 
Pane. 

Expand the asset path until you get to the measurement where the alarm levels are set.  Click the 
alarm levels to select them.  The two following figures show the Navigation Pane and Trend Plot with 
the Over (Alert) and Over (Danger) alarm levels added to the plot.  

 

 

 

Danger Level 
Alert Level 



 

Page 154 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

10.2.14 Channel Ordering 

SETPOINT CMS orders the channels alphabetically using the PI AF Description field.  By default, 
CMS loads the Description field with the channel name so the default channel order is alphabetical 
by channel name.  You can change the channel order by appending a numerical value at the 
beginning of the Description field as shown in the table below.  For example, to number the channels 
for 2 bearings down a machine train, you could append the highlighted numbers: 

 

Bearing Channel  Description Field 

Driver Outboard 
 

1 1.1 Driver OB RV X 

2 1.2 Driver OB RV Y 

Driver Inboard 
 

3 2.1 Driver IB RV X 

4 2.2 Driver IB RV Y 

Adding the highlighted numbers in the Description field as shown will cause these points to be 
ordered from outboard bearing to inboard, X then Y.  If two channels have the same number 
appended, these two channels will be ordered alphabetically using the text following the numbers. 

A good scheme to follow is to number in a hierarchy from highest to lowest level separating each level 
with dot.  For example: 

1. Machine 

1.1 Case 

1.1.1 Bearing 1 

1.1.1.1 X Probe 

1.1.1.2 Y Probe 

1.1.2 Bearing 2 

1.1.2.1 X Probe 

1.1.2.2 Y Probe 
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NOTE! 
You will need to close and reopen the SETPOINT CMS Display program to see the channel 
ordering change. 
 

 

 
  

Append numerical values to the 
Description field to order the channels 
from lowest number to highest. 
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10.2.15 Compensation 

Compensation allows you to remove unwanted noise content from the signal you are analyzing.  
Removing mechanical and electrical runout, scratches, or shaft bow enhances the view of the 
dynamic shaft information.  This section discusses the types of compensation the VC-8000 system 
performs and the steps to configure and use compensation. 

SETPOINT CMS performs three types of compensation:  Vector, Waveform, and Gap compensation. 

The basic steps to using compensation are: 

• Tag a data sample as reference 

• Select the sample to use for compensation 

• Turn on/off compensation 

10.2.15.1 Vector Compensation 

Compensation applied to filtered timebase and orbit, polar, and bode plots uses vector compensation.  
Vector compensation subtracts the selected compensation vector from the vibration vector and plots 
the waveform of resulting vector difference. 

10.2.15.2 Waveform Compensation 

You can apply waveform compensation to any dynamic data plot collected synchronously.  This 
includes orbit and timebase.  It also includes spectrum, cascade, and waterfall plots when displayed 
in orders of running speed.  Waveform compensation subtracts the slow roll compensation waveform 
from the current waveform sample-by-sample and is very effective at removing unwanted frequency 
components up to ½ the sampling rate (Nyquist frequency). 

 

 

NOTE! 
Waveform compensation requires a Phase Trigger association. 

 

10.2.15.3 Gap Compensation 

Gap compensation subtracts the selected reference gap value from the gap value readings before 
plotting.  Gap compensation is used primarily with the shaft centerline plot. 
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10.2.16 Select Compensation Sample 

Select the reference sample for compensation from the reference data pane.  You can use different 
reference data samples for slow roll vector compensation, waveform compensation, and gap 
compensation. 

 

View the compensation vector measurements in the reference data table. 
  

Hover over the reference sample 
to use for compensation and click 
Slow Roll, Waveform or Gap. 
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10.2.17 Pinning Plots 

Pinning a plot causes the plot to display regardless of plot settings.  Plot pinning is useful when you 
want to compare several specific plots or for selecting plots for reporting.  Pin plots will change time 
range or time as the selected time or dynamic cursor are changed.  Pinned plots retain compensation 
and filtering set when the plot was pinned. 

To pin a plot, click the pin icon    in the upper right corner of the plot.  Then turn off the plots and 
only the pinned plots will remain displayed. 

10.2.18 Pop Out Plot 

Any plot can be moved to a second window by right clicking on the plot and selecting Pop Out Plot.   
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10.2.19 Time Lock 

Right click and select lock time to freeze time for a given plot so that multiple plots can be reviewed over a 
range of time. 
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10.2.20 State Marker 

10.2.20.1 Add State Marker 

State markers may be added on zoom trend with context menu Add State to annotate when machine 
state changes occur. The created state is shown as bar with a flag on zoom pane.  
 

 
 

               
 

The added states are also displayed as events in the Events Pane. 
 

 

Clicking on the state event time 
centers the selected time range 
on the event time.   

State bar   

Click a location you want to add the state marker. 
Then right clicking on zoom pane and clicking Add 
State menu, an adding dialog will be displayed 
where you can define Name, Description and Color 
of the new state. 

The cursor time is 
used for the state 
marker and it is not 
editable in the 
dialog.  
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NOTE! 
The state markers are only visible on zoom pane if Data Annotations from the View Tab is 
activated and only the states of the selected assets can be displayed.  
 
A state marker can only be added to one selected asset (asset path defined with *). If there 
are more assets selected while adding, an error message will be shown.  

 
Please deselect all of the other assets and try adding state again.  
 
If there is no asset path defined in the hierarchy, the state will be added under root node by 
default. 
 

 
 

10.2.20.2 Edit / Delete State Marker 
 

An existing state marker can be edited or removed with by right-clicking on the marker and selecting 
form the menu options. The color and texts are editable, but time cannot be changed. 

 
 

                                                 
 
  

Moving mouse near to a 
state bar or flag area, a 
context menu is shown. 
 
Clicking Delete State will 
remove the state from the 
system. 
 
Clicking Edit State, a dialog 
box appears.   
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10.2.20.3 State Based Display 

 

 

 

States can be used to color plot data based on assigned states if State Based button is toggled on.  
This allows vibration data to be taken in context of state so that it is not incorrectly diagnosed.  For 
example a bode plot can visually show what data is in startup and what is in coastdown. If State 
Based button is toggled off, the plot is drawn with trace colors. 
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10.2.21 Error Messages 

CMS will show a red X error indicator if there is a problem presenting the plot.  Hover over the X to 
see a description of the problem.  In the example below, 2X filtering and compensation were turned 
on but no reference sample had been selected for compensation: 

 

 
 

Error Description Action 

No Data There is no data in the 
database in the selected time 
range. 

Increase the selected time range. 

No Compensation The plot cannot be 
compensated because 
reference data is not set. 

Set a reference sample. 

The plot cannot be 
compensated because the data 
time and reference time are the 
same resulting in a null 
waveform. 

Move to a time different from the 
reference sample. 

Y and X Probes are not 
orthogonal 

The X and Y probes are not 90 
degrees apart (less than 80 
degrees or more than 100 
degrees) 

Adjust the probe orientation if 
possible.  SETPOINT CMS 
software will automatically adjust 
the data for non-orthogonal 
probes.  However, errors 
increase the farther the probes 
are from 90 degrees. 

  

Hover over the red X to see a 
description of the plot error. 
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10.3 Plots 

After navigating to a point, clicking the plot buttons on the Home Tab will open that plot type for the 
selected points.   

The plot buttons are shown below followed by descriptions of each available plot type. 

 

 

The Trend plot shows static values as a function of time.  
  
 

 

The Data Table shows the numeric values of the measurements. 
  
 

 

The Orbit plot is a two dimensional path of shaft centerline motion as viewed from an 
orthogonal transducer pair (XY). 
  
 

 

Selecting both the Orbit and Time buttons allows visualization of orbit and timebase 
waveforms side by side. 
 

 

The Bode plot allows you to view the 1X, 2X, or nX forward vector amplitude and phase 
as a function of shaft rotational speed.  
 

 

The Polar plot shows vector amplitude and phase data plotted on polar coordinates. 

 

The Shaft Centerline plot shows the movement of the shaft average centerline position 
over time. 
 

 

The Spectrum Plot allows you to view the vibration amplitude as a function of frequency 
in either half or full spectrum formats. 
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The Waterfall plot shows spectrums collected over a period of time. 
 

 

The Cascade plot shows spectrums collected as a function of speed. 

 

The Air Gap button plots present the rotor profile waveforms of multiple air gap channels.  
 

 

The Crank Angle button plots reciprocating compressor measurements as a function of 
the compressor crank angle position. 
 

 

The Displaced Volume button plots reciprocating compressor measurements as a 
function of the compressor cylinder displaced volume. 
 

 

The Rod Position plot shows reciprocating compressor X-Y rod position. 
 

 

The Compressor Map plot shows the operating point, surge control line, and surge limit 
line for a centrifugal or axial compressor. 

 

The timebase plot is the instantaneous amplitude plotted as a function of time.  Single or 
multiple channels can be displayed simultaneously, whether from the same bearing or 
multiple bearings.  
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10.3.1 Orbit Plot 

The Orbit Plot shows the dynamic shaft motion in relation to a pair of orthogonal transducers.  

 

You can adjust your Orbit plot using these options: 
• Filtering to 1X, 2X or nX components 

• Compensate 

• Adjusting the number of Revolutions 

shown 

• Manual Scale 

• Auto Scale 

• Change the Machine Orientation 

• Overlay Data 

Go to Plots overview 
 

 

NOTE! 
If only one channel of an XY Pair is selected, CMS will find the paired sensor and plot the 
Orbit. 

Probe Locations 

Rotation Direction 

Blank-Bright indicates 
phase trigger marks and 
shows the direction of 
precession. 

Machine 
Orientation 



 

© Brüel & Kjaer Vibro ● S1176125.002 / V03 ● █ Page 167 of 234 
Technical alterations reserved! 

© Brüel & Kjaer Vibro │Instruction Setpoint Condition 
Monitoring Software  Using the CMS Display Software  EN 
   

10.3.2 Timebase Plot 

The Timebase plot shows the dynamic transducer signal plotted against time similar to the 
presentation that would be seen on an oscilloscope. 

 

You can adjust your Timebase plot using these options: 

 
• Filtering to 1X, 2X or nX components 

• Compensate 

• Adjusting the number of Revolutions 

shown 

• Manual Scale 

• Auto Scale 

• Zoom in on a section of the plot 

• Overlay Data 

• Show Asynchronous Timebase 

 
Go to Plots overview  

Speed, probe orientation, amplitude, time and 
date when the data was stored. 

Blank-Bright indicates 
phase trigger marks. 
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10.3.3 Orbit/Timebase Plot 

The Orbit/Timebase plot shows both the Orbit and Timebase plots for the XY channel pair.  

 

You can adjust your Orbit/Timebase plot using these options: 

• Filtering to 1X, 2X or nX 

components 

• Compensate 

• Adjusting the number of 

Revolutions shown 

• Manual Scale 

• Auto Scale 

• Change the Machine Orientation 

Reference 

• Overlay Data 

 
Go to Plots overview  

Channel amplitudes or 
vectors if filtered. 
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10.3.4 Trend Plot 

The Trend plot shows static values plotted against time.   

When analyzing a trend plot you can: 

• Change the time range 

• Auto Scale the Y axis 

• Manually scale the Y axis 

• Zoom in on a section of data 

• Use cursors to see the values 

• Show when signals entered and 

exited alarms 

Data 

• Change which channels show 

• Change which measurements show 

• Plot alarm set points on the trend 

 

 

NOTE! 
You can also quickly hide or show Trend traces.  Click on the trace name in the legend to hide 
the trace.  The trace name will be greyed out.  Click it again to show the trace. 

Go to Plots overview 

Alarm annotations 

Points and 
value at the 
cursor time 

Begin Time                                                                     End Time 

Cursor Time 
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10.3.5 Bode Plot 

This Bode plot shows the Direct reading and 1X, 2X, or nX vector amplitude and phase as a function 
of shaft rotational speed. 

 

 When analyzing a Bode Plot, you can: 

• Show Direct, 1X, 2X, or nX data 

• Compensate 

• Autoscale the speed and amplitude axis 

• Manually set the speed and amplitude axis 

• Apply cursors 

• Overlay Data 

 

NOTE! 
You can also quickly hide or show Bode traces.  Click on the trace name in the legend to hide 
the trace.  The trace name will be greyed out.  Click it again to show the trace. 

Go to Plots overview  

Speed and Cursor Time 
Point name and orientation 
Measurements and overlays, with values at cursor time. 

 

Phase Lag 

Amplitude 
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10.3.6 Polar Plot 

The Polar plot shows vector amplitude and phase data plotted on polar coordinates. 

When analysing polar plots, you can: 

• Show 1X, 2X, or nX data 

• Compensate 

• Autoscale the speed and amplitude axis 

• Manually set the speed and amplitude axis 

• Apply cursors 

• Overlay Data 

• Label points with speed or time 

Go to Plots overview  

Speed andTime at cursor 
Point name, orientation 
Amplitude and Phase at cursor 

Compensation 
vector applied 

Rotation 
Direction 

Begin Time                                                                        End Time 

Phase Trigger 
Orientation 

Machine Speed 
at point 
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10.3.7 Shaft Centerline Plot 

The Shaft Centerline plot shows the movement of the shaft average centerline position over time or 
shaft rotational speed.  The average centerline position is determined from XY displacement probe 
DC gap voltages. 

 

The Shaft Centerline plot requires configuration of 

• Plot Start Point 

• Clearance Boundary 

• Start Reference 

• Machine Orientation 

• Overlay Data 

• Label points with speed or time 

 
Go to Plots overview 
 

Probe Locations 

Rotation 
Direction Speed and 

positions at the 
cursor time 

Plot Unit 
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10.3.7.1 Setting the Start Reference (Initial Gap) 

The Shaft Centerline plot will default to setting the first sample in the time range to the plot zero 
location.  Alternatively, you can plot the data with the zero position at a set gap reference location.    

To set a starting reference: 

1. Set a reference sample for the dataset. 

2. Choose the reference sample as the “gap” reference. 

3. CMS will draw the shaft absolute plot starting at the gap value of the selected reference 
sample. 

 

10.3.7.2 Setting the Start Position 

The start position sets where to begin plotting the shaft centerline movement and represents the plot 
origin (0,0).  Set the start position from the Plot Settings Pane. 

 

Machine Orientation Typical Start Position 

Horizontal 
 

Bottom 

Vertical 
 

Center 

Overhung Rotor Top 
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Bottom:                                                                               Top:                

                                                                   

Center: 

 
 
 
 

 

NOTE! 
Autoscaling the shaft absolute plot can cause the bearing clearance to be outside the plot 
scales and to not be shown. 
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10.3.8 Spectrum 

This screen allows you to view the vibration amplitude as a function of frequency in either half or full 
spectrum formats. 

 

• Change the number of spectral lines shown 

• Change the windowing 

• Show data in orders of running speed or frequency 

• Show the full spectrum 

• Integrate velocity or acceleration spectra 

• Overlay Data 

• Show Bearing Cursors 

The X axis scaling always uses the manual scales.  You can auto scale or manually scale the Y axis.  

Go to Plots overview 

Plot Speed and Time 
Channel Names, Cursor X position 
resolution, Windowing 
Data values at cursor 
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10.3.9 Waterfall 

The waterfall plot shows spectrums collected over a period of time. 

When analysing waterfall plots, you can: 

• Change the spectrum resolution 

• Change the maximum number of 

spectrums shown 

• Apply windowing 

• Plot with the x axis in orders or 

frequency 

• Plot full or half spectrum 

• Show plot walls 

• Integrate velocity spectrums to 

displacement or acceleration 

spectrums to velocity 

• Auto or manual scale 

• Rotate the plot 

• Enlarge or shrink the plot 

• Reset the plot to the default view 

• Apply cursors

Go to Plots overview  

Plot Speed and Time 
Channel Names, Cursor X position 
resolution, Windowing 
 
Data values at cursor 
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10.3.10 Cascade 

The cascade plot shows spectrums collected over changes in speed. 

 

When analysing cascade plots, you can: 

• Change the spectrum resolution 

• Change the maximum number of 

spectrums shown 

• Apply windowing 

• Plot with the x axis in orders or 

frequency 

• Plot full or half spectrum 

• Show plot walls 

 
 
Go to Plots overview 
 

 
• Integrate velocity spectrums to 

displacement or acceleration 

spectrums to velocity 

• Auto or manual scale 

• Rotate the plot 

• Enlarge or shrink the plot 

• Reset the plot to the default view 

• Apply cursors 

Plot Speed and Time 
Channel Names, Cursor X position 
resolution, Windowing 
  
Data values at cursor 
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10.3.11 Data Table 

The data table shows the measurement numerical values for the selected points. 

 

Go to Plots overview 
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10.3.12 Reciprocating Compressor Plots 

The reciprocating compressor plots include the Rod Position plot and the ability to plot various 
measurements against the crank angle and displaced volume. 

10.3.12.1 Rod Position Plot 

 

With the Rod Position plot you can: 

• Adjusting the number of Revolutions shown 

• Show Alarm Limits 

• Manual Scale 

• Auto Scale 

• Overlay Data 

• Go to Plots overview 

 

Horizontal Channel 

Danger Setpoint Alert Setpoint 

Rod Position 

Vertical Channel 
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10.3.12.2 Associating Channels with a Throw 

In order to plot dynamic measurements as a function of the reciprocating compressor crank angle or 
displaced volume, you must associate the channel with a throw.  Rod Position and Cylinder Pressure 
channels are automatically associated to a throw in the reciprocating compressor configuration.  
Associate vibration and other dynamic measurements to the reciprocating compressor using the 
Asset Path on the SETPOINT Setup Software Asset Framework configuration view.  The following 
configuration example shows the Recip Crankcase Velocity 1 and Crosshead acceleration channels 
associated with the Comp A123 Throw 1.  When these points are selected in CMS along with the 
throw, CMS can plot these vibration measurements as a function of crank angle or displaced volume. 
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10.3.12.3 Plotting vs. Crank Angle 

You can plot any dynamic measurement associated with the reciprocating machine as a function of 
the shaft crank angle. 

Rod Load Diagram 

 

Pressure vs. Crank Angle 

 
  

Inertial Load Gas Load Total Rod Load 

Load Reversal Points 
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Acceleration vs. Crank Angle 

 

 
  

NOTE: You must select the Recip Cylinder 
Throw to plot measurements against the 
crank angle. 
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10.3.12.4 Plotting vs. Displaced (Swept) Volume 

You can plot any dynamic measurement associated with the reciprocating machine as a function of 
the cylinder displaced volume. 

Pressure-Volume Diagram 

The pressure-volume diagram shows the cylinder pressure as a function of displaced volume (0% to 
100%) 

 

Showing the Adiabatic Theoretical Curve 

You can show the theoretical adiabatic curve on the pressure volume diagram when plotted as a 
function of displaced volume.  The theoretical curve is a useful tool when diagnosing compressor 
faults. 

 

On the Plot Tab, under Recip, check the 
Adiabatic Curve box to show the theoretical 
curve. 
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In order to plot the adiabatic curve you must enter the isentropic exponent for the compressed gas 
mixture.  Use an Equation of State solver (purchased or available on the Internet) to calculate the 
isentropic exponent.  Enter the isentropic exponent under the cylinder attributes for the head and 
crank chambers:

 
 

Adiabatic curve 
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10.3.13 Air Gap Plot 

The Air Gap plots present the space between the rotor and stator. It indicates the rotor profile 
waveforms of multiple hydro air gap channels. The minimum and maximum poles which should be 
monitored are shown around the rotor profiles. The sensor locations are marked around the outside to 
orientate the data.  There are also tooltips available for each sensor marker and minimum / maximum 
pole if you move the mouse near these locations. According to the angle axis and pole numbers 
shown on the plot you can find out the rotation direction and pole numbering direction. The following 
example shows that the rotation is clockwise and the pole numbering is counter clockwise. 

 

 

Alert and danger limits are drawn on the plot to visually track how close a pole is to a setpoint.  

While moving the mouse from pole to pole, each area is highlighted. If clicking at one location, one 
pole is selected and the following readout is presented on the right or the top pane of the plot: 

• Rotating speed and timestamp 

• The gap values of each sensor at the selected pole 

• Selected pole index and the number of total poles (example 1/24) 

• Alarm limits which are defined by the Minimum Air Gap under same Air Gap channel 

 

Sensor 
Marker 

Angle 

Pole 
Readout 

Min/Max 
Pole 

Danger/Alert Limit 

Selected 
Pole 
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To scale the Air Gap plot you can activate Auto Scale or change it manually with Settings dialog of 
each plot or Change Scales button to edit the maximum radius.  

               
 
 
 

10.4 Documenting 

SETPOINT CMS has several ways to document the results of your analysis: 

• Copy and paste plots into another program 

• Export Trend data to a CSV file 

• Export all plots to a Microsoft Word document 

 

10.4.1 Copying and Pasting Plots 

Hovering over a plot will enable a camera icon in the upper right hand corner.  Clicking the camera 
icon copies the plot to the clipboard for pasting into reports. 
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Use the paste command (cntl-V) to paste the plot into another document. 
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10.4.2 Export Trend Data to .CSV File 

You can quickly export the trend data for the selected points and selected time range to a comma 
separated file for further processing or sharing using a program such as Microsoft Excel.   

From the File Tab, click Export and Export CSV Data: 
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When opened in Microsoft Excel, the path lists the point name.  The timestamps, data values, data 
status, and speed values for each sample are shown in the following columns. 

 

 

 

NOTE! 
The default Excel time formatting does not show the hour.  Click on the cell to see the full 
date/time or change the Excel cell format to “time”. 
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10.4.3 Exporting all Plots to Microsoft Word 

You can export all the currently open plots to Microsoft Word in one quick process.   

From the File Tab, select Export and Create Document: 

 

Set the document type to Word Document (.docx) and type in a file name.  SETPOINT CMS will 
create the document with all the currently open plots. 

 

NOTE! 
If the export lists that errors occurred during the export, check your plots in CMS for error 
indications. 

 

 

NOTE! 
Limit the Trend plot to less than 10 traces for best export presentation. 
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11 Using the Removable SD card Media 

When enabled, the SAM can collect steady-state and transient data and store the data in files on the 
SAM SD card.  You can open the .cmssd file and view the data using the SETPOINT CMS Display 
software without any networks or servers. 

 

The SD card is located at the top of the SAM module installed in slot 2 as shown below: 

 

 

IMPORTANT! 
To use the SD card functionality, the SAM must be enabled for the SD card, UMMs and TMMs 
must be CMS enabled, and the SD card function enabled in the VC-8000 configuration.  Refer 
to the VC-8000 Operation and Maintenance manual for information on enabling the SAM SD 
card functionality. 

11.1 Card Types and Sizes 

SD 2.0 suitable to 32 GB.  SETPOINT recommend using 32 GB cards. 

Class 10 Speed rating, 10 MB/s or higher 

The SD card should be rated to the VC-8000 environmental ratings.  SD cards should be Industrial 
Temperature Rated for -20 to +85 °C unless your rack is in a climate controlled environment. 

 

 

IMPORTANT! 
Scan the card for viruses before inserting into the SAM. 

SD Card 
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Industrial temperature SD cards are available in both SLC (Single Level Cell) and MLC (Multiple Level 
Cell) technology.  SLC technology cards support more erase/write cycles than MLC cards but are 
considerably more expensive.  For most applications, MLC cards will work fine.  However, if you 
configure the rack to save waveforms at a high rate during steady state conditions then you should 
consider upgrading to SLC cards. 

11.2 Data Storage 

The amount of data stored and the time duration before the card fills and starts over-writing depends 
on several key factors: 

• The number of channels 

• Dynamic channels vs. position and temperature channels 

• The number of transient events 

• Boost mode 

While data storage can vary, the system will adapt to the machine operating conditions to optimize 
the amount of stored data. 

11.2.1 Data Organization 

Data is stored in 50 MB blocks (before compression) in intervals no longer than 5 minutes.  If the 
system records 50 MB of data in less than 5 minutes, the files will be closer together. 

11.2.2 Compression 

There are multiple levels of compression used to maximize the data storage on the SD card. 

11.2.2.1 Static Data Compression 

Using patented techniques, Setpoint adjusts compression levels according to the how the machine 
operation is changing and how much data has previously been stored under similar operating 
conditions.   

11.2.2.2 Dynamic Data Compression 

Dynamic Data is compressed using the various techniques listed in this section. 

i-Factor 

If the UMM detects that the signal has not changed since the last waveform sample stored it will 
discard the waveform.  Waveforms are stored based on a calculated “interestingness” in comparison 
to the last stored waveform.  CMS will automatically adjust the i-Factor data collection rate during 
steady state conditions to optimize the data storage. 
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Boost Mode 

Boost mode data is collected and stored continuously and is not compressed.  Boost mode should be 
limited to infrequent, short transient intervals such as fast startups and coast downs.   If the speed 
stops changing while still in the transient range the UMM will exit boost mode until it begins changing 
again.  If the buffer in the UMM fills up it will exit boost mode and resume normal collection until a 
certain percent of the buffer empties out. 

Delta RPM 

For machines that startup or coast down slowly, delta rpm waveform sampling allows a waveform to 
be published at set speed changes.  If no other waveforms have been published during the 
configured periodic interval the most interesting waveform for that interval is then published.   

Dynamic Collection Rate 

The Dynamic Collection Rate set in the UMM configuration sets a maximum amount of time that 
expires between saving waveforms.   If no other waveforms have been saved during the configured 
periodic interval the most interesting waveform for that interval is then saved.  Note that since the 
most interesting waveform is saved, the interval between saved waveforms can be double the 
configured interval if the first waveform of one interval is saved and the last waveform of the next 
interval is saved.  Set the dynamic collection rate to a longer time to extend the SD card storage time. 

11.2.3 Overwriting 

When the SD card fills the system will overwrite the data, overwriting the oldest data first in 50 MB 
blocks.  The SAM OK LED will blink green on/off when the card is full.  Only cms files are overwritten.  
The system will not overwrite other files stored on the card. 

 

 

NOTE! 
To maximize data storage, remove any non-CMS files stored on the card.  These files will not 
be overwritten and will reduce the available storage. 

11.3 Enabling 

The SD card data collection and storage requires CMS enabled UMMs or TMMs to collect the data 
and an SD card enabled SAM.  Order enabler keys at the time of purchase or contact Brüel & Kjær 
Vibro Services to upgrade existing racks. 
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11.4 SD card Status 

You can verify correct SD card operation from the front panel display, from the SAM LEDs, or from 
Modbus status registers. 

11.4.1 SD card Status on Display and LEDs 

The SD card status is shown using the SAM OK LED.  You can use the LED indications to see the 
SD card status if your system does not have a display.  The display indication and OK LED patterns 
below will only occur when the SAM is enabled for SD card data storage. 

 

Display Indication OK LED Color 
Pattern 

Indication 

SD OK Solid Green 
 

The card is installed, the system is correctly collecting data, 
and the card is currently not being written to.  It is safe to 
remove the card. 

SD Full Blinking Green 
 

The card is installed, the system is correctly collecting data, 
but the card is full and the oldest data is being overwritten.  
The card is currently not being written to.  It is safe to remove 
the card. 

SD Busy Blinking Green/Amber The card is installed, the system is correctly collecting data, 
the card is currently being written to.  Wait until the blink 
pattern returns to solid or blinking green before ejecting the 
card. 
 
The LED will also blink this pattern when the UMMs have 
buffered Boost Mode data and is spooling this data to the SAM 
for writing to the SD card. 
 
The SD Busy indication on the display shows a progress bar 
for data moving from the UMM to the SD card.  If the 
background is showing partially blue, there is data still in the 
UMMs waiting to be written to the card. 

No SD Solid Amber There is no card installed or the system is rebooting and the 
system cannot detect the card.  Wait for the system to finish 
booting and verify a card is inserted.  

SD Fail Blinking Red The system cannot write to the SD card.  This may be 
because the SD card is corrupted, unformatted, or has write-
protection on.  Replace the card with a valid card. 
 
The LED will also blink red if a front panel firmware upgrade 
from the SD card fails.  Remove the card and replace with a 
card with a good firmware file or no firmware file to abort the 
upgrade. 
 

N/A Solid Red They system has failed and is not collecting or storing data. 
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11.4.2 SD Card Status via Modbus 

The SD card statuses are located in the Modbus Map at registers 12445 and 112445.  Refer to the 
VC-8000 Operation and Maintenance Manual S1079330 for more information on Modbus. 

In addition to the statuses shown on the display, Modbus also provides a SD Card Locked status 
which indicates if the card write enable switch is on or off. 

11.5 Removing the Card 

The SAM processor periodically writes data to the SD card.  Removing the card while the processor is 
writing data can cause loss of the 50 MB (five minute) file currently being written.  The write cycle 
typically lasts 20 seconds.  When writing, the display shows the SD card as “SD Busy” and the SAM 
OK LED will be alternately blinking green and amber.  When the write cycle is complete the display 
will show “SD OK” or “SD Full” and the SAM OK LED will return to either solid green or blinking green 
on/off.   
You can install an SD card at any time. 

 

 

IMPORTANT! 
Removing the SD card while the system is writing data can cause loss of the last 50 MB or 5 
minutes of data.  Wait until the SD card is not busy before ejecting. 

 

 

WARNING! 
In hazardous locations do not eject or insert the SD Card unless the environment has first 
been proven safe. 

11.6 Copying Card Data 

You can copy the files and folders from the SD card directly to a computer hard drive.  There will be a 
file named <RACK NAME>.cmssd and a folder <RACK NAME>.  Copy both of these.  Log files or 
other information on the card is not required.  You can merge new data into the same folders with 
data previously collected on the same rack as long as the rack configuration has not changed. 

 

 

NOTE! 
If the rack configuration has changed, copy new data into a different location.  Do not merge 
the data folders. 

 

 

NOTE! 
Depending on your computer and the amount of data on the SD card, it can take a long time 
to copy to a computer.  Best practice is to replace the card when it is removed so that data 
collection continues. 
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11.7 Viewing Card Data 

To view the data on the SD card, insert the card into a computer.  You can view the files directly from 
the SD card or copy the files to a local folder.  When opening the files, the CMS Display will 
automatically find and concatenate all of the 50 MB (5 minute) .cms files in the folder.  You can use 
CMS to analyze the full range of time saved.   

Open the SD card data from the File Tab, Open File, with the file type CMSSD. 

The file will open with the selected time range set to the last hour on the card. 

11.8 Configuration Changes 

The SD card data only supports one configuration.  If you are changing your VC-8000 configuration, 
eject the SD card and copy all the files before changing the configuration.  Insert an empty SD card 
after downloading the configuration changes to the VC-8000 rack.  

11.9 Using the SD card for Data Collection Redundancy 

When enabled, the SAM can store data to the SD card simultaneously while spooling the data to a PI 
Server.  This provides a level of redundancy in the event of a network failure in that critical data is still 
available on the SD card. 

11.10 Backfilling SD Card Data into a PI Server 

Refer to Section 14 for information on backfilling data stored on an SD card into a PI Server. 
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12 CMS-XC Data Storage on a Local Computer 

The SETPOINT CMS-XC option spools CMS data files to the storage drive on a computer without 
requiring a local PI Server.  This feature is useful for: 

• Applications where a local PI Server is not practical. 

• Backing up the data sent to the PI Server. 

• Portable or temporary data acquisition. 

Figure 38 shows a CMS-XC installation where a PI Server local to the machine is not practical.  The 
CMS-XC computer provides a large data storage drive and the necessary security software required 
for connection to the Wide Area Network (WAN).   

 

Figure 38:  CMS XC on a WAN 
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The CMS Display can connect to the CMX-XC computer and view the data files in the same way as 
connecting to a PI Server.  

 

Figure 39 shows a CMS-XC computer serving as a backup to the local PI Server.  CMS-XC stores all 
data from the VC-8000 rack on a local drive.  If there is a fault on the either the Local PI Server or a 
remote Main PI Server the CMS Display PC can still view the SETPOINT data stored on the CMS-XC 
computer. 

 

Figure 39: CMS-XC Backing up a PI Server 

 

 

NOTE! 
CMS-XC only backs up data collected by the VC-8000 racks and does not back up process 
data in the PI Server collected from other instrumentation. 
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12.1 Configuring a CMS-XC Computer 

Configure the CMS-XC computer using the SETPOINT-PI Adapter Setup software.   See Section 
8.1.2 for information on configuring the XC computer storage locations and folder names. 

 

12.2 Configure Windows Remote User Access 

You must give remote users Windows security access to the CMS-XC data.  Follow the instructions in 
this section to configure CMS-XC access for individuals or groups of users. 

 

 

NOTE! 
Install the Setpoint Adapter before performing this step.  The Setpoint Adapter will 
automatically create the Setpoint Remote Users group. 

Configure the users from the Windows Computer Management.   

 

Alternatively, you can open the Computer Management dialog from Control Panel by selecting 
Adminstrative Tools and then Computer Management. 

The Computer Management dialog will open: 

Open the Computer Management 
dialog from the Windows Start menu 
by right clicking on Computer and 
then selecting Manage. 
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Add user names under object names and click OK.   You will need to enter each user that will access 
the XC database.  Alternatively you can give access to all domain users for a specific location using 
the Domain Users object as shown in the following picture: 

In the Computer Management dialog, click Local Users 
and Groups, and then Groups in the Name Pane. 

Right click the Setpoint Remote 
Users group and select Add to 
Group. 
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12.3 Configuring the Network Firewall for CMS-XC 

To allow remote access to the CMS-XC data (see Figure 38 and Figure 39), you will need to have 
Firewall ports 8001 and 8002 open. 

12.4 Backing Up CMS-XC Data 

Brüel & Kjær Vibro recommends backing up CMS-XC data folders.  There are many ways to do this.  
Contact your Information Technology department or Brüel & Kjær Vibro Services for backup solutions. 

12.5 Viewing Old CMS-XC Data Files 

When you connect to a computer running CMS-XC the open database view will only show racks that 
are currently configured in the Setpoint Adapter.  If you have changed the rack name or removed a 
rack from the adapter you can still view the data in the CMS Display.  CMS-XC data uses the same 
format as CMS-SD data and you can open the cmssd files from the File Tab. 
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13 CMS-HD Data Storage in the Rack 

CMS-HD uses an internal solid-state drive (SSD) to store static and dynamic data.  Depending on the 
SSD size purchased and the configured data collection rate the SSD can store months or even years 
of data. 

You can connect a computer Ethernet cable directly to the CMS port on the front of the SAM module 
or you can access the HD data via a network as shown in Figure 40. 

When connecting a computer directly, you do not need a crossover cable or switch.  The SAM will 
automatically detect the cable and adjust accordingly.  You will need to verify that your computer IP 
Address is configured for the same subnet as the CMS port. 

 

 

Figure 40:  CMS HD Network 

 

 

IMPORTANT! 
The SETPOINT rack CMS port is not designed to be placed on an exposed network.  If the 
network is accessible externally use the CMS-XC solution. 
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NOTE! 
The CMS HD feature requires the SAM to have a password configured.  Refer to the VC-8000 
manual S1079330. 

 

 

IMPORTANT! 
The CMS-HD storage drive will overwrite when full.  Periodically copy the HD database to a 
computer or save important reference data in a .cms file. 

13.1 Configuring HD Storage 

Setpoint HD does not require configuration.  HD enabled hardware will automatically store condition 
monitoring data from CMS enabled monitoring modules. 

13.2 Monitoring HD Storage 

The Setpoint CMS system can create a very large amount of data.  Eventually the HD storage will fill 
and automatically begin to overwrite.  To prevent loss of important data, periodically import the HD 
database or view and save important data from Setpoint CMS.   

The Setpoint display provides basic information on the HD storage which you can use to determine 
when to upload and save data.   

Refer to Section 15.5 for information on verifying data storage rates. 

13.3 Copying HD database to a Local Drive 

Refer to Section 14.2. 

13.4 Automatically Backfilling HD Data into a PI Server 

You can configure the Setpoint-PI Adapter to automatically backfill data from Setpoint HD into your PI 
Server in the event of network communication failure.  (See Section 8.2 to enable or disable.) 

When the backfilling option is active, the Setpoint-PI Adapter checks for Setpoint HD data not already 
in the PI Server when: 

• The Setpoint-PI Adapter Service is first started 

• When communication to the Setpoint rack is restored after being lost. 
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NOTE! 
Backfilling does not apply PI Compression for points that already contain data in the PI 
database.  Backfilled data may store more samples than when on line. 

 

 

IMPORTANT! 
Backfilling large amounts of data can severely stress a PI Server.  If your PI Server also 
performs critical plant operations that cannot be interrupted, consider disabling the backfilling 
option and backfill manually (See Section 14) at a convenient time. 

 

 

NOTE! 
Backfilling does not import data prior to when the rack was added in the Setpoint PI Adapter.  
Follow the instructions for importing a dataset (See Section 14) for migrating Setpoint HD data 
stored in the rack prior to connection to a PI Server. 
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14 Uploading SD, XC, or HD Data into the PI System 

You can upload machine data stored on the SD card, stored in an XC database, or stored on the 
internal solid state drive into a PI System.  This feature is useful for: 

 

• Racks that cannot be connected to the network. 

• Data collection from portable racks 

• Racks collecting data before the PI System was installed. 

• Data stored during network outages 

 

The Setpoint-PI Adapter will automatically create any points that exist in the SD, XC, or HD 

database but do not already exist in the PI database and allocate PI Tags as required. 

 

 

NOTE! 
If the rack name already exists in the PI-AF database the Setpoint-PI Adapter will merge 
the uploaded points under the existing rack.  Set a unique rack name for each SD, XC, 
or HD rack if you need the data separated. 
 

 

Uploading data to the PI System involves these steps: 

1. Create new PI Archives (if required) 

2. Export XC or HD data to be uploaded to a local drive. 

3. Upload the data into the PI System. 

14.1 Creating PI Archives 

If the data stored on the SD card, XC database, or HD database predates the PI System, you will 
need to create PI archives in which to store the data.  Follow the steps in this section to create PI 
archives.  

To create an archive:  

In PI System Management Tools, open the Archives plug-in. 
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The Create New Historic Archive dialog will open: 

 

 

3. Select Create a New Archive. 
(or right-click and select Create 
New). 
  

1. Chose the Server 
  

2. Navigate to Operation, Archives 
  

Select Create Archive with Fixed 
Start and End Time. 
 
For Start Time, enter a time 
equal to or earlier than the oldest 
timestamp for data to be 
backfilled. 
 
For End Time, enter the start 
time of the oldest current 
archive. 
 
Select Dynamic as the archive 
type.  
 
Click OK to create and register 
the archive. 
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14.2 Exporting an HD or XC CMS Database 

If the data is stored in CMS-XC or CMS-HD files, you need to export the data to a local database file 
before uploading into the PI System.   

 

 

NOTE! 
The Export CMS Database option will only be active if you are currently connected to a CMS 
HD or CMS XC database. 
 

 

 

NOTE! 
The Export CMS Database option will export data only for the currently selected points and 
time range.  Be sure to select the points and set the time range before exporting. 
 

 

The export process will require you to specify a location to store the database.   
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14.3 Uploading XC or HD data in the PI System 

From the Setpoint-PI Adapter, select Options and then Upload. 

 

 

 

Set the location of the CMS SD 
database or location where CMS XC or 
HD data was exported. 
 
The PI Server, AF Server, and AF 
Database fields will auto-fill according to 
the PI System Settings.  
 
Click OK to upload the data into the PI 
System. 
  



 

© Brüel & Kjaer Vibro ● S1176125.002 / V03 ● █ Page 209 of 234 
Technical alterations reserved! 

© Brüel & Kjaer Vibro │Instruction Setpoint Condition 
Monitoring Software  Verification  EN 
   

15 Verification 

This section lists ways to verify the data flow between the SETPOINT rack and the database (PI 
System, XC, SD, or HD.)  

15.1 Verifying Connection to the Setpoint-PI Adapter 

To verify that the SETPOINT rack is properly connected to the Setpoint-PI Adapter and the system is 
collecting data, open the Setpoint-PI Adapter Setup program and verify that the rack status is 
“Collecting”. 

 

15.2 Verifying Data in the PI System Database 

PI System Explorer provides tools for verifying the data stored in the PI System Database.  Follow 
these steps to verify SETPOINT data in the PI System Database. 

Open PI System Explorer.  PI System Explorer will be listed under the PI System folder: 

 

 

Verify that the Setpoint-PI Adapter is 
collecting data from the rack. 
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The Time Series Data window will open.  Setting the End Time to “*” causes the time range to end at 
the current time.  Setting the Start Time to “*-8h” sets the range to start 8 hours earlier than the 
current time.  Click the Refresh button.  The Time Series Data window shows the number of 
samples stored in the PI System in the time range and a plot of the data values.   

2)  Click the Database button.  A window 
will open where you can select your AF 
Server and AF Database.  

3) Expand the Elements to get to the 
measurement you want.  

 4) Select the Attributes tab. 

5) Right click the data value and 
select Time Series Data. 
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Set the Start Time and End Time and 
click the Refresh button. 

View the number of samples stored in 
the PI System database and a plot of the 
samples. 



 

Page 212 of 234 █  © Brüel & Kjaer Vibro ● S1176125.002 / V03  
 Technical alterations reserved! 

EN 
 
 

  

15.3 Forcing a Waveform Sample 

Under normal operating conditions, SETPOINT will automatically collect waveforms on detected 
changes in machine state.  There may be times, such as when you are verifying system operation, 
when you need to force the system to record a waveform and store it in the database for immediate 
viewing. 

To force a waveform, open the SETPOINT Maintenance application and navigate to the Firmware 
Upgrade view.  (See Manual S1079330 VC-8000 Operation and Maintenance Manual.)  In the 
Firmware Upgrade view, click the Boost button as shown. 

 

 

15.4 Data Annotations 

The Data Annotation function provides information about when SETPOINT collected waveforms and 
how interesting the machine data is.  Data Annotations are useful when troubleshooting waveform 
collection.  Activate Data Annotations from the View Tab. 

 

15.5 Verifying Data Storage Rates 

You can verify the rate at which the system is currently sending data to the database.  

 

Clicking the Boost button causes the 
SETPOINT rack to collect and store a 10 
seconds of boost mode waveforms for 
the selected channel. 
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From the front panel display or the 
Setpoint Maintenance software open the 
rack view.  Click the SD, HD, or CMS 
buttons on the SAM to see information 
on data collection rates and storage.  

For SD and HD, the details view 
shows this information: 
 
Storage write rate.  This is the 
amount of data being written to 
the storage device per second 
and is also displayed on the bar 
graph.   
 
The Data Start is the oldest data 
stored since the last export. 
 
The Data End is date of the most 
recent data stored. 
 
Capacity:  The installed storage 
device size. 

For networked connections to a PI 
System or Setpoint-XC view the 
CMS details. 
 
Data rate indicates the network 
data bandwidth usage. 
 
Adapter shows the status of the 
Setpoint-PI Adapter. 
 
Link shows if green if there is a 
valid Ethernet connection to a 
Setpoint-PI Adapter. 
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IMPORTANT! 
Data storage rates will vary greatly depending on whether the machine is in steady-state or 
transient conditions.   

Click the More button on the details view to see more storage statistics.  For SD and HD the view 
below will show: 

 

These values show: 

HD Write Rate:  The rate at which data is being written to the HD storage device. 

HD Available Free Space:  The unused space on the HD storage device. 

 

 

NOTE! 
The HD storage device is not erased when data is exported.  Old data will remain on the HD 
storage device until it is filled at which time the old data will be overwritten.  When the HD 
Available Free Space is 0, new data is still being stored but old data not previously exported is 
being lost. 

HD Read Rate:  The rate that data is being read from the HD storage device.  In most cases this will 
be very low unless a user is connected to the HD device with the Setpoint CMS Display software. 
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For CMS connections to a PI System or CMS-XC system the following view will show: 

 

These values show: 

Ethernet Send Rate:  This value indicates the amount of network bandwidth being consumed by 
outgoing messages.  Since this value is measured before data compression done by the PI System it 
is not necessarily indicative of the amount of data being stored on the PI Server. 

Ethernet Received Rate. This value indicates the amount of network bandwidth being consumed by 
incoming messages. The Ethernet Received Rate will increase when a user is requesting data from 
the HD through the Setpoint CMS software. 

Adapter Status:  The overall Setpoint-PI Adapter status.  When green the adapter is operating 
correctly.  If yellow, one or more adapter connections (PI System or CMS-XC) have failed. 

Link Status:  When green the rack is correctly communicating with the Setpoint-PI Adapter.  When 
yellow, the rack cannot communicate with the adapter.  This may be due to physical network 
problems or problems with the adapter. 
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16 Maintenance 

In general, SETPOINT CMS database maintenance is similar to maintaining any other OSIsoft PI 
database.  Refer to OSIsoft PI system manuals and videos.  This section lists maintenance specific to 
SETPOINT CMS. 

16.1 Monitoring the Database Size 

Use PI System Management Tools for viewing and managing the database.  Go to Operation, 
Archives to see a list of the archive files the PI system created.   

 

 

From the list, you can see that from October 19th 2013, to November 19th 2013 server DEMONET_PI 
stored 31 archive files of 256 MB each.  Total storage rate for this system is approximately 8 GB per 
month.  Since this system has 1.74 TB of available storage, under similar operating conditions this 
system would take approximately 18 years to fill the hard drive.  In this case, no action is required.   

 

 

NOTE! 
SETPOINT CMS collects much more data during transient machine conditions than steady 
state.  Monitor your database more often when machines are changing states. 
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16.2 Archive Backup 

Refer to OSIsoft documentation for best practices on backing up your data archives. 

16.3 Adjusting Compression 

You can adjust the PI Server data compression to increase or decrease the amount of stored data.  
The default compression settings are set to the typical noise floor of the sensor type and resolution of 
the signal processing.  If your machine frequently changes operational conditions, you may want to 
increase the compression levels to avoid collecting excessive data.  CMS automatically reduces 
compression during transient speed conditions.  OSIsoft has several excellent videos on the Internet 
explaining how to adjust the compression settings and how PI data compression works.  Brüel & Kjær 
Vibro Services also can help with adjusting compression settings. 
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17 Troubleshooting 

17.1 Plot Messages 

The SETPOINT CMS Display Application will print a message across the plot if there are problems 
with the data.   The following table gives a description of the problem and suggested corrective action. 
Table 14: Plot Error Messages 

Error Message Description Corrective Action 

No Data 
Data necessary for the plot type does not exist in 
the selected time range. 

Change the time range to include 
data. 

Invalid Data 

The data is invalid.  This may be caused by a 
range check error, a speed error, or the speed or 
amplitude are too large or small to calculate the 
value. 

Verify that the synchronous sample 
rates were set according to Table 9.  
Check transducer wiring. 

Y and X probes are 
non-orthogonal 

The probe orientations are not configured with X 
following Y by 90 degrees in a clockwise direction. 

Fix the probe orientation 
configuration so that the probes are 
90 degrees apart. 

No Compensation 
Compensation is active but no compensation 
vector or waveform is set for the point. 

Select a reference data sample for 
compensation. 
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17.2 Data Collection Problems 

There are a variety of installation and configuration problems that can affect data collection.  This 
section lists some of the most common problems and solutions.  Contact Brüel & Kjær Vibro Service 
for additional troubleshooting information. 
Table 15:  Troubleshooting Data Collection Problems 

Problem Possible Causes Actions 

Adapter fails to connect to 
rack 
 

Ethernet Wiring Problem 
Verify the link and activity lights at the rack and 
server. 

Incorrect Firmware Revisions 
Verify that all firmware revisions are new enough 
to support CMS.  See Table 4 :  SAM Firmware 
Revision for Function. 

Network IP Address Incorrect 

Verify that the SAM IP Address is on the same 
subnet as the computer running the SETPOINT-
PI Adapter (See Sections 7.1 and 0.)  Use Ping 
command to verify communication. 

Adapter fails to connect to 
PI Server 

Server not running 
Restart the PI server. 

Adapter fails to build AF 
hierarchy 

Not enough PI Tag licenses 
available 

Verify that you have enough PI Tag licenses 
(Refer to OSIsoft documentation). 

No PI Tags allocated 

Asset Path not filled in Assign asset paths to the channels. 

Channels are not on. 
Verify the channels are turned on. 
 

No data collected 

Adapter service not running 
Verify the SETPOINT-PI Adapter is running and 
collecting. 

Module is not enabled. 

Verify that the monitor module is CM-Enabled.  
See Section 3 

 Incorrect Rack Time 

Verify the rack time and time zone are set 
correctly (see Manual S1079330).  If the rack 
time is incorrect, the rack may be trying to store 
data in the future or distant past in relation to the 
set server time. 

Cannot connect to server 
from the CMS Display 
software 

Server not connected to 
network 

Verify that the server computer is connected to 
the same network as the client computers and 
configured with a valid network IP address. 

Machine is not changing or 
Dynamic Collection Rate set 
too long. 

Adjust the Dynamic Collection Rate. 
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No Orbit, Time-base, or 
Spectrum data in selected 
time range 

Machine is running very slow. 
Wait for the waveform collection to finish.  A 
waveform at 3 rpm can take over 5 minutes to 
collect. 

No Spectrum Data 
Spectrum set for Full Spectrum, 
but a single channel selected. 

Change to half spectrum or ensure that the 
selected level includes channel pairs. 

No Orbit or Time-base 
Data 

Phase Trigger not assigned 
Phase Trigger not triggering 
 

Verify the phase trigger configuration.   

No new data collected 
The client is connected to an 
old database. 

Verify the Adapter and the Client are using the 
same PI Database.  See Sections 9.1.1 and 
8.1.1. 
Verify the system is time synchronized. 

Cannot save reference 
data. 

Insufficient permissions to the 
database. 

See Section 6 for information on setting 
database permissions. 

Excessive data collected 

Loose sensor wire or failing 
sensor. 

Fix the sensor or temporarily Increase 
measurement Dynamic Collection % Change 
Threshold.  (See Section 7.3.2) until the sensor 
is fixed.  Turn on Adaptive Interestingness. 

Machine continually changing 
measurement levels 

Increase measurement Dynamic Collection % 
Change Threshold.  See Section 7.3.2. 
Turn on Adaptive Interestingness 

 
Figure 41: Verifying Channel is Active 

  

 
  

Verify Channel On checkbox is checked. 

Verify the Channel is associated with a 
Phase Trigger if applicable. 

Verify the configuration was sent. 
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17.3 Display Problems 
 

Table 16: Troubleshooting Display Problems 

Problem Possible Causes Actions 

3-D Plots display as black 
rectangles 

Computer graphics card does not 
support the 3-D graphics. 

Upgrade graphics card.  Contact Brüel 
& Kjær Vibro Services for information. 

Add Database is grayed out on the 
Open Database screen. 

PI AF Client software is not 
installed. 

Install a compatible version of OSIsoft 
PI AF Client software. 

Data sources are missing after a 
software upgrade. 

Preferences not migrated from 
legacy “Metrix” folder to 
“Setpoint” folder. 

Copy files from C:\Users\ <User 
Name>\ AppData \Roaming \ Metrix\ 
Setpoint\CMS to 
C:\Users\<UserName> 
\AppData\Roaming \Setpoint\CMS 

Plots take a long time to display 

Insufficient memory available. 
Close other applications that may be 
using large amounts of memory. 

Very large number of waveforms 
is slowing the system when 
showing data annotations.  

Turn off Data Annotations and 
Waveform Tick marks. 

Cannot set reference data. 
User does not have proper 
database permissions 

Assign permissions per Section 6. 

Plot appears blank 
Manual scaling set too small or 
large. 

Try auto-scale, if Orbit appears, adjust 
the manual scale. 

All plots are blank 
Bookmark opened for a server 
you are not connected to. 

Return to the Home screen and log 
into the server which has the 
bookmarked data. 
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18 Additional Functions 

OSIsoft PI supports many additional functions such as: 

 

• Notification 

• Rules 

• ERP 

• CMMS 

• Exporting 

• OPC 

Contact OSIsoft for more information. 
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19 Appendix 

19.1 PI ProcessBook Integration 

19.1.1 Launching SETPOINT CMS Display from PI Process Book 

You can easily add a button to your PI Process Book to launch the SETPOINT CMS Display 
Application and open with data for the selected asset and specific plots.   

 

The section below provides a brief overview on how to create a button in ProcessBook.  OSIsoft has 
many videos on the Internet showing how to create views in ProcessBook.  Please refer to these for 
more detail.   

Follow these steps to create a button that launches the CMS Display from PI ProcessBook: 

Open the PI display you will be adding the button to. 

Clicking this button will launch 
SETPOINT CMS for Minden Unit 501 
Bearing 4. 
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1) Size the button on the display by dragging out the size.  PI will open a dialog box to define the 
button as shown below.  Type a name for the button in the Text field. 

Se”C” 

2) For the Action, browse to the SETPOINT CMS application.  If installed in the default folder, 
the path is as shown in the figure above. 

3) Set the Working folder to the folder where the CMS application is located. 

4) Save the process book.  Clicking on the button will launch the CMS application. 

The CMS Display by default will open with the default database.  To open the CMS Display with a 
specific database and asset, create and name a bookmark in CMS. Then append the bookmark at the 
end of the command line. 

1) Enter build mode by clicking the 
hammer icon. 
 
2) From the Draw menu, select button. 
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Where the syntax is: 

“C:\Program Files (x86)\Setpoint\CMS\Setpoint.Client.CMS.exe” “<bookmark>” 

 

 

 

NOTE! 
ProcessBook requires the quotation marks around the call and path.  Be sure to include the 
quotation marks as shown in the example. 

 
  

Bookmark name 
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19.1.2 Command Line Controls CMS 2.5 

You can further control the views by turning on and off plots and defaulting to auto-scale.  To do this, 
add a plot command following the path.  Table 17 shows the supported plot commands. 
Table 17: Plot Command Line Controls 

Command Description Action 

Plots.ShowOrbit Orbit plot control for the set machine path. 
True: Opens Orbit Plot 
False: Closes Orbit Plot 

Plots.ShowTrend Trend plot control for the set machine path. 
True: Opens Trend Plot 
False: Closes Trend Plot 

Plots.ShowShaftCenterline 
Shaft Centerline plot control for the set machine 
path. 

True: Opens Shaft Centerline 
Plot 
False: Closes Shaft Centerline 
Plot 

Plots.ShowSpectrum Spectrum plot control for the set machine path. 
True: Opens Spectrum Plot 
False: Closes Spectrum Plot. 

Plots.ShowBode Bode plot control for the set machine path. 
True: Opens Bode Plot 
False: Closes Bode Plot. 

Plots.ShowTime Timebase plot control for the set machine path. 
True: Opens Timebase Plot 
False: Closes Timebase Plot. 

Plots.DefaultAutoScale Turns on or off the autoscale function. 
True:  Turns Autoscale  on 
False: Turns Autoscale off 

 

Example 

“C:\Program Files (x86)\Setpoint\CMS\Setpoint.Client.CMS.exe” “\\PISERVER\Setpoint_Demo2\Minden\Unit 
501\B4” Plots.ShowSpectrum=True Plots.ShowOrbit=False 

This example navigates to Bearing 4 on Minden Unit 501 in database Setpoint_Demo2 on AF Server 
PISERVER.  The analysis screen will open with the default Orbit plot turned off and the Spectrum plot 
turned on. 

You can also set the time range from the ProcessBook command line. 
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Table 18: Time Command Line Controls 

Command Description 

“Time.StartRange=MM/DD/YYYY HH:MM:SS PM” Sets the beginning time to the listed date and time. 

“Time.EndRange=MM/DD/YYYY HH:MM:SS PM” Sets the end time to the listed date and time. 

“Time.DynamicTime=MM/DD/YYYY HH:MM:SS PM” Sets the dynamic time cursor to the listed date and time. 

Example: 

“C:\Program Files 
(x86)\Setpoint\CMS\Setpoint.Client.CMS.exe””\\PISERVER\Setpoint_Demo2\Minden\Unit 501\B4” 
“Time.StartRange=05/23/2013 12:18:16 PM” “Time.DynamicTime=05/25/2013 3:10:05 PM” 
“Time.EndRange=05/28/2012 2:19:42 PM” 

This example navigates to Bearing 4 on Minden Unit 501 in database Setpoint_Demo2 on AF Server 
PISERVER.  The begin time is set to 12:18:16 PM on May 23 2013, the end time is set to 2:19:42 PM 
on May 28 2013 and the dynamic cursor is set to 3:10:05 PM on May 25 2013. 

19.1.3 Command Line Controls CMS 3.0 

CMS 3.0 discontinued use of the command line controls used by CMS 2.5 and uses bookmarks 
instead.  Creating bookmarks is much simpler than defining plots in the command line. 

 

When you create the bookmark in CMS, navigate to the hierarchy level of the asset or points you 
want shown when launching CMS from the button.  Open the plots you want shown and then create 
the bookmark.  Set the bookmark name in CMS and use the same bookmark name in quotation 
marks when defining the button in PI ProcessBook.  

Bookmark name in quotations following 
the application. 
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19.2 Using SETPOINT CMS in Parallel with an Existing Rack 

You can use the VC-8000 rack in parallel with an existing rack in order to collect condition monitoring 
data into SETPOINT CMS while leaving the existing machine protection system in place.  Refer to the 
SETPOINT Machinery Protection System Operation and Maintenance manual (Document 
#S1079330) for information on how to set the channel inputs for connection to buffered outputs from 
another rack. 

19.3 Using CMS with one VC-8000 Rack and Different Assets 

Test stand and portable diagnostic applications may require using the same VC-8000 rack for data 
collection on different machine assets.  SETPOINT CMS has tools for managing your data and racks 
when collecting data for test runs on different assets or for different jobs.  When using test runs, CMS 
starts and stops multiple VC-8000 racks together and also allows you to assign security permissions 
to the various test run datasets to control access. 

19.3.1 Enabling Test Runs 

Open the SETPOINT-PI Adapter Setup utility.  From the File menu, select Options and check 
Enable Test Runs to enable test run data collection.  The play and pause buttons will move to the 
header and apply to all racks. 
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19.3.2 Set the Root Path 

CMS prefixes the machine asset hierarchy with the Root Path providing an easy way to find data 
collected for a specific machine using the same rack.  For example, you can categorize data by 
customer name or machine serial number by changing the root name.  

 

The syntax is the same as for the machine asset hierarchy. 

 

 

NOTE! 
It is easier to find test runs if the name appears on the CMS home screen.  When configuring 
the machine asset hierarchy it is generally better not to place an asterisk in the VC-8000 
hierarchy.  Instead, place an asterisk in the Root Path node. 

 
  

With recording stopped, change the Root 
Path, then toggle the recording button to 
start recording data with the new path.  
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19.3.3 Starting and Stopping the Data Collection 

Each time you start data collection, CMS will record a new test run event. 

 
 
 
 

 

NOTE! 
You must place an asterisk in the Root Path name and start data collection for the new Root 
Path to show up on the CMS home screen. 

 

 

NOTE! 
If you are already collecting data and change the Root Path, CMS will immediately start 
collecting data under the new name after you click Send. 

 
  

19.3.4 Navigating to Test Run Data 

You can navigate to test runs from the File Tab.  If test runs are enabled and there are test runs 
completed, the Open Database view will show a test run column.  Click on the test run icon to open 
data for that test run.  

Click the Record button to toggle 
between recording and stopped modes.  
The mode applies to all listed racks.  
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Click a test run to open the analysis view 
with data from that test run. 
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19.4 File Extensions 
 

Table 19:  SETPOINT File Extensions 

File extension Description 
.set SETPOINT 

VC-8000 Configuration + diagnostic in a single file type but can be opened by either 
SETPOINT maintenance or SETPOINT setup SW.  If you open a file containing only 
configuration information, the maintenance software will indicate that no diagnostic 
information is available, such as when creating a configuration on your laptop before 
connecting to a physical rack – or a legacy configuration file where diagnostic information 
was not saved. 

.setk SETPOINT KEY 
VC-8000 CM-Enabler key(s) 

.cms Condition Monitoring Software  
A single file containing CMS-formatted data.  Can span no more than 7 days.  Saves data 
only for the selected channels or assets. 

.cmssd CMS Storage Directory  
Used with CMS-SD, CMS-HD, and CMS-XC to point to directory containing unformatted 
CMS data.  Individual unformatted files use a variety of extensions and cannot be opened 
and read by CMS Display directly.  They are meant to be opened as groups of files via the 
.cmssd extension.  Unlike 7-day limit on .cms files, .cmssd has no limit on number of days 
spanned. 

.cmsdb CMS Data Base 
Same as .cmssd.  The extension was changed to show that these files are not limited to 
CMS-SD, but are also used for CMS-HD and CMS-XC.  Cmsdb files include all channels 
and assets in the database regardless of the currently selected channels or assets. 

.met METRIX 
Tied to Metrix heritage. This same .met extension was used for configuration and 
diagnostic files.  Configuration files can only be opened using the SETPOINT Setup 
software, diagnostic files can only be opened from the SETPOINT maintenance software. 
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20 Glossary 

Term Definition 

Asset Path The hierarchy from the point up though the asset tree.  For example:  
PLANT\TRAIN\CASE\BEARING\CHANNEL 
Configure the asset path in the SETPOINT Setup software. 

Asynchronous 
Waveform 

Dynamic waveforms samples collected at a fixed sample rate regardless of machine 
speed. 

Attribute 
 

An attribute is a PI AF component that describes a property of the parent element. 
For example, a measurement may have a danger set point attribute.  Attributes can 
be assigned to any level in the asset path hierarchy.  Attributes are not trended by 
the PI System unless they are mapped to tags so will only show the current value 
when they are read.  SETPOINT CMS reads the attributes when opened.  If 
attributes are changed in PI AF you must close and reopen SETPOINT CMS.  

Boost Mode 
 

An operational mode which causes CMS to collect data continuously during transient 
events.  Enable or Disable Boost mode from the SETPOINT Setup software. 

Dynamic Data Dynamic data includes synchronously and asynchronously sampled data streams 
used for plotting Orbit, Timebase, and Spectrum plots. 

Full Spectrum Plots the complex spectrum using signals from a pair of orthogonal transducers.  The 
full spectrum shows the forward and reverse precessing values as a function of 
frequency and is essentially the spectrum of an orbit. 

Half Spectrum Plots the signal amplitude as a function of frequency from a single transducer. 

Precession Precession is a change in the orientation of the rotational axis of a rotating body.  For 
machinery, this is the motion of the rotor geometric center in the plane perpendicular 
to the rotor axis.  Precession can be in the direction or rotation (forward precession) 
or against the direction of rotation (reverse precession). 

Static Data Static data includes filtered and processed samples used for Trend, Bode, Polar, 
Shaft Centerline, and Data Table plots. 

Synchronous Waveform A dynamic waveform sample collected in fixed intervals of phase over each machine 
revolution.  For example, a synchronous waveform collected at 128 samples/rev will 
take a sample every 2.8125 degrees of rotation. 

Vector A machine vibration component having both a magnitude and a phase angle.  The 
phase angle is the measured phase lag from a Phase Trigger event to the magnitude 
peak.  Vectors are typically described in relation to the machine running speed:  1X = 
synchronous to the machine running speed, 2X = synchronous to twice the machine 
running speed, nX where n is a variable value. Vector data is used to for Bode, 
Polar, Filtered Orbits and Timebase plots 

XY Pair Two transducers mounted 90 degrees apart (orthogonal) at the same machine 
location measuring the vibration in two planes.  Setpoint will treat UMM channels 1, 2 
and 3, 4 as channel pairs for Orbit, Full Spectrum, and Shaft Centerline plots when 
they are both configured as Radial Vibration. 
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